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Introduction
In this guide, the following icons are used.

The Network Imaging System Print Client Software allows you to print files from your Sun Solaris system 
as part of a network printing system. The software captures user input, builds a print request, and transfers 
that print request either directly to a specified printer or to a  print server. The print server handles the 
print request, resulting in the printing of the document. Input can be received through a graphical user 
interface (GUI) or a command line interface.

You determine what documents are to be printed and how they should be processed by printers and 
finishing devices. Once a specified printer is selected you then select from a list of printing, paper, and 
page options, such as stapling, paper type, and copy count. Print options may be saved for future use.

Features

Available features vary depending on the selected printer. Following is a list of printing features. Not all 
features are available on every printer.

• Two-sided printing

• Multiple set collating

• Stapling

• Printing pages on different paper stock

• Offset stacking

• Inserting separator sheets

• Using transparencies

• Booklet printing

• Folding

• Accent color

Interfaces

Graphical User Interface

The GUI for Print Client Software allows you to provide the input necessary for the print client to build 
print requests. It also provides you with some convenient functions, such as the ability to store and load 
saved print options and define paper types.

Command Line Interface

The command line interface allows you to provide input to the Print Client Software application and 
create print requests without executing the GUI. You can invoke the Print Client Software from the UNIX 
command line or UNIX scripts.

This icon indicates that you should read the caution message that follows.

This icon indicates that you should take note of the important information that follows.
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Introduction
When you use the command line to input to the print client, a document file and a print options file are 
specified.  The print options file is stored by the GUI and may be referenced in a command line when 
you invoke Print Client Software. Optional arguments can override some of the selections in the print 
options file (for example, number of copies, server, or print device).

A print options file may be created using an ASCII text editor. However, the preferred method for creating 
print options files is through the GUI. 

For more information about command line interface input, refer to Appendix A “Command 
Line Interface”.
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Section 1   Installation and Configuration
This chapter provides the hardware, software, and network requirements, and general information that 
you should read prior to installing the Print Client Software. For detailed installation instructions refer to 
the Network Imaging System Installation Tool Guide publication.

Hardware Requirements

The following configuration is required to load Print Client Software:

• Sun Ultra 10, Ultra 30 or Ultra 60 workstation, running Solaris 2.6, 5/98, and
OpenWindows 3.X

• CD-ROM drive

• 100 MB of swap space minimum

• 32 MB of RAM minimum

• 6.0 MB of available disk space minimum

Assumptions

You should be familiar with the following:

• Solaris 2.6 environment

• OpenWindows environment

• UNIX directory structure

• Basic file management tasks in a UNIX/OpenWindows environment

• Document printing characteristics and printer features

Installing the Software

Refer to the Network Imaging System Installation Tool Guide publication for installation instructions.

Configuring the Software

Root user privileges are necessary for performing software configuration procedures. Before configuring 
the software, log in as root using the following procedure.

To log in as root:

  1. Open a command tool.

  2. Type su - [RETURN].

  3. Type the root password and press [RETURN].

The following types of software configurations are documented in this chapter:

• Setting up the available Network Imaging System servers and printers to which the Print Client 
Software will have access

• Setting up each Print Client Software user’s environment

• Setting up the system defaults, including the preferences, paper catalog, and
print options
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Installation and Configuration
• Setting up the user defaults, including the paper catalog, print options, and
interface preferences

Setting Up the Available Servers and Printers

If you have not already set up access to the servers and printers, you need to do so before you 
can print using Print Client Software. You must be logged in as root to run the Product
Configuration utility.

Setting Up Servers

To set up the servers:

  1. In the root user command tool, type /usr/srv/bin/config.scl [RETURN].

The following prompt appears.

  2. Type y [RETURN].

The Current List of Servers prompt appears.

  3. Type a [RETURN] to add a server to the list.

The following prompt appears.

Each print server must have print queues available. If a server has no print queues, jobs sent 
from Print Client Software will not print and no error message will appear.

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=
Print Client Software

Product Configuration Utility
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=

This program modifies the list of Print Servers that the Print Client 
Software has access to. For each Print Server, access to the server’s 
Printer Database must also be established. This is required so that 
the Print Client knows what printers are available, and what they have 
for finishing devices.
p
Do you still want to continue? [y|n]:

### CURRENT LIST OF SERVERS ###
Entry Name
----- ----
Enter Server List command [s|a|d|x] (use ? for help):

The “<” and “>” characters must be included when you type <Local> or <None>.

Adding a new server to the list.

<None> = No server, print directly to printers.
<Local> = Print Server Software on this host.
hostname = Name of remote machine with Print Server
Software installed.
Enter <None>, <Local> or the server’s hostname:
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Installation and Configuration
Perform the following steps to set up servers or direct printing, or both.

  4. If you will print through a print server on a remote machine:

a. Type the name of the remote machine which has a Print Server Software installed, then press 
[RETURN].

When you type the server’s hostname, the software attempts to set up access to the remote 
Print Server’s Printer Database using the Solaris automounter.
Messages on the screen indicate whether the attempt was successful.

b. If automount was not successful, you must manually establish access to the database by 
performing the steps to set up a remote server on page 1-4.

When the printer database configuration is completed, the following prompt appears.

  5. Type a [RETURN] to add another server to the list.

Repeat step 4–step 5 for each server you want to add.

  6. Type x [RETURN] when you are finished adding servers.

A message appears stating that the list of servers is being saved and that the Print Client 
configuration is complete.

Setting Up Printers

When you are printing without choosing a print server (that is, using the <None> server entry), you must 
create a database of printers before you can print to them using Print Client Software.

When attempting to print jobs to printers attached to remote servers, it is preferable to select the remote 
server by its host name for the server preference rather than the <Local> server, even if the local server 
has queues for the remote printers.

The no server (<None>) and local server (<Local>) will have been set up automatically dur-
ing installation.

When configuring access to printers which are attached to remote print servers, if there are 
queues for the remote printers on the local server, it is possible to access the printers by 
using <Local>  for the server configuration. However,  since the local server may not have 
an accurate representation of the finishing devices available on the remote printers, it is 
preferable to set up the remote server using its hostname and then select that server when 
printing to the remote printers.

Enter Server List command [s|a|d|x] (use ? for help):
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Installation and Configuration
To set up printers:

  1. In the root user command tool, type /usr/srv/bin/edit_printer_db.scl [RETURN].

The following prompt appears.

  2. Type y [RETURN].

The Current List of Printers appears.

  3. Type a [RETURN].

A prompt appears asking you to enter the printer’s network hostname.

  4. Type your printer’s network hostname and press [RETURN].

A prompt appears asking you to select your printer type.

  5. Type your response and press [RETURN].

A prompt appears asking you to select the printer’s finishing device.

  6. Type your response and press [RETURN].

  7. Repeat step 3–step 6 for each printer you want to add.

  8. When you are finished adding printers to the list, type x [RETURN].

To set up a remote server:

To send jobs to Print Server Software installed on remote systems, Print Client Software must have access 
to the remote server’s printer database.

If automount access was not possible in step 4 of  “Setting Up Servers” on page 1-2, access must be 
established manually by copying the database from the remote server or by mounting the file system from 
the remote server.

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=
Print Client Software

Printer Database Configuration Utility
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=

This program is used to identify the printers that the Print 
Client  has direct access to. You will be asked to enter each 
printer’s network hostname, printer type, and what finishing 
devices are attached to it.

Do you still want to continue? [y|n]:

### CURRENT LIST OF PRINTERS ###

Entry Name Type Finishing Devices
---- ----- ---- -----------------

Enter Printer List command [s|a|d|e|q|x] 
(use ? for help):

The local system must be listed in the remote server’s /.rhosts file in order to use the rcp 
command. See your system administrator to gain access to the remote server’s /.rhosts file 
or use ftp to obtain a copy of the database.

Any changes made by Print Server Software will not be reflected in Print Client Software 
until the printer database is copied again from the remote system and Print Client Software 
is restarted.
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Installation and Configuration
To establish access by copying the database:

  1. Open a command tool on the local system.

  2. Type su - [RETURN].

  3. Type the root password and press [RETURN].

  4. Type cd /usr/srv/lib/databases/databases.scl/printer_dbs/
remotehost [RETURN].

Replace remotehost with the name of the remote system.

  5. Type rcp remotehost:/usr/srv/lib/databases/databases.prt/
installed_printer_db . [RETURN].

Replace remotehost with the name of the remote system.

The installed_printer_db file in the remote system’s Print Server Software is copied into the current 
directory.

  6. Type cd ../remotehost [RETURN] to set up the next remote system.

Replace remotehost with the name of the remote system.

  7. Type rcp remotehost:/usr/srv/lib/databases/databases.prt/
installed_printer_db . [RETURN].

Replace remotehost with the name of the remote system.

Continue the Print Client Software setup with “Setting Up the System Defaults” on page 1-7.

To establish access by mounting the remote server’s filesystem:

  1. Log in as root on the remote system.

  2. Type textedit /etc/vfstab [RETURN].

  3. Add the following text string to the file:

remotehost:/usr/srv/lib/databases/databases.prt – /usr/srv/lib/
databases/databases.scl/printer_dbs/remotehost nfs – yes ro,bg,soft

The entire text string must be entered on one line without a [RETURN]. The line may automatically 
wrap to the next line. Replace remotehost with the name of the remote system.

The file system must be mounted as read only (ro).

  4. Repeat step 3 for each remote system.

  5. Save and exit the file.

The period ( . )is part of the command.

The period ( . ) is part of the command.
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Installation and Configuration
  6. Type mountall [RETURN].

  7. The printer database directories must be made available on the remote host using the “share” or 
“export” command. To do this, refer to the Print Server User’s Guide.

The remote server’s file system is mounted.

Setting Up the Environment of Unix Users

Print Client Software requires that certain environment variables with specific values be set up for each 
Unix user.

This is done automatically for the root user and Network Imaging System operator user (kdkoper) at 
installation.

For the Network Imaging System operator user (kdkoper):

  1. Open a command tool.

  2. Type su - [RETURN].

  3. Type the root password and press [RETURN].

  4. Type  cd ~kdkoper and press [RETURN].

  5. Type  textedit .cshrc and press [RETURN].

  6. After the last line in the file, add a new line with the following, starting at the beginning of the line: 
setenv SCAN_DOC_INBASKET <TIFF document path>.

Replace <TIFF document path> with the full pathname of the desired directory.

  7. Save the file and quit textedit.

If the Print Client Software application was already opened, it needs to be restarted for the settings to take 
effect.

For other UNIX/OpenWindows user accounts (if they exist):

  1. Type su - <userid> and press [RETURN].

  2. Type the user’s password and press [RETURN].

  3. Type  textedit .cshrc and press [RETURN].

  4. After the last line in the file, add a new line with the following, starting at the beginning of the line: 
setenv SCAN_DOC_INBASKET <TIFF document path>.

Replace <TIFF document path> with the full pathname of the desired directory.

  5. Save the file and quit textedit.

  6. The user must log out then log back in for the settings to take effect.

If Unix/OpenWindows users accounts besides kdkoper and root are 
required, contact your systems engineer.
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Installation and Configuration
Setting Up the User’s Default TIFF Document Directory

When a user starts the Print Client Software and attempts to add a TIFF document to the filename(s) list, 
the default starting directory for the Insert window is
/var/spool/scanned_documents.scl. If a different starting directory is desired, perform the following 
procedures.

Setting Up the System Defaults

The system defaults were established during installation. You should establish system defaults for the 
Preferences window before you use Print Client Software. You must be logged in as root in OpenWindows 
to modify any system default. The fields in the Preferences window are described on page 1-10.

To modify the system default preferences file:

  1. As root, type cd /usr/srv/lib/databases/databases.scl [RETURN].

  2. Type textedit sys_def_preferences [RETURN].

You are in the system default preferences file.

  3. Edit the values after the colon for each configurable item in the file.

For example, type cm after Units to change the default units from inches to centimeters. Value 
choices are listed within the brackets.

  4. Save the file and quit textedit.

The system default preferences file is set up. Continue with the following procedures to set up the 
system default paper catalog and the system default print options.

Default Paper Catalog:

Normally, the default paper catalog for the Print client is automatically updated to match the printer’s 
catalog.  It is possible to disable the automatic update of the Print Client default paper catalog by 
performing the following procedure.

To disable the automatic Paper Catalog update:

  1. Open a command tool.

  2. Type su - [RETURN].

  3. Type the root password and press [RETURN].

  4. Type   cd /usr/srv/lib/databases/databases.scl    [RETURN].

  5. Type  textedit update_cat_conf.scl   [RETURN].

  6. Find the line “value = TRUE”. Replace the word “TRUE” with the word with the word “FALSE” 
so that the line reads, “value = FALSE.”

  7. Save the file and close textedit.

To modify the system default paper catalog:

The Print Client default paper catalog is normally updated to match the system paper catalog anytime the 
system paper catalog is changed.  If you wish to maintain an independent paper catalog for the Print Client 
first perform the procedure above, “To disable the automatic paper catalog update. Then you may modify 
it using the following procedure:

  1. As root, type /usr/srv/bin/sclient.scl & [RETURN].
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Installation and Configuration
Print Client Software starts up.

  2. Use the Print Client Software Paper Catalog window to make modifications to the default paper 
catalog.

  3. Position the pointer over the File button in the Paper Catalog window.

  4. Hold down the Menu mouse button and select Save Paper Catalog on the File menu.

  5. The paper catalog is saved. The changes will automatically be propagated to all users.

To switch to a different paper catalog:

If you are adding a new printer to your network that is a different type than used previously, you may 
want to add the standard paper definitions for that printer type to your current default paper catalog, or 
replace your default catalog with the Print Client combined paper catalog which includes the standard 
paper definitions for all printers.

For example, if you have been using the Print Client Software with a Network Imaging System and have 
added another copier-printer to your network, you may want to either switch to the combined paper catalog 
or add the additional copier-printer definitions to your current catalog.

  1. As root, type  cd /usr/srv/lib/databases/databases.scl/media  [RETURN].

  2. Type  cp /.printdir/media_catalogs/def_media_catalog.mc . [RETURN].

  3. Enter the following command:

To add the paper definitions for all supported printers from the combined paper
catalog to your current catalog:

Type cat combined_media_catalog.mc >> def_media_catalog.mc [RETURN].

Type  cp def_media_catalog.mc /.printdir/media_catalogs/  [RETURN].

  4. Enter the following commands:

cp -p combined_media_colors media_colors  [RETURN]

cp -p combined_media_sizes media_sizes  [RETURN]

cp -p combined_media_types media_types  [RETURN]

cp -p combined_media_weights media_weights  [RETURN]

To set the system default print options:

After establishing the system default paper catalog, it is recommended that you set up the system default 
print options.

  1. Select the necessary options in the Print Client Software windows.

  2. Position the pointer over the File button in the Print Client Software main window.

  3. Hold down the Menu mouse button and highlight Save Print Options As from the File menu.

The period (.) is part of the command.

Even if you do not have specific options that you want to set, it is recommended that you 
perform step 2-step 6.
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Installation and Configuration
  4. Slide the pointer to the right and select Standard Print Options on the Save As submenu.

A list of standard print options files will appear, including <User Defaults> and 
<System Defaults>. <System Defaults> appears only for root.

  5. Select <System Defaults>.

  6. Click the Select mouse button on the Apply button.

Changes are saved as the system default print options.

Follow the instructions for setting up the user default print options under “Setting Up the User Defaults” 
in this section.

Setting Up User Default

After you install Print Client Software, you can set up the user default paper catalog and user default print 
options.

To set the user default print options:

After you switch to a new paper catalog or change display languages, each Unix/OpenWindows user may 
need to save his or her user defaults again. To determine if you need to do this, perform the steps below.

You may get one of the following warning messages when you start up the Print Client Software.

• The attributes for the following paperpaper name which is in either the current job or in your user 
defaults does not match the current catalog.  The attributes in the current catalog will be used.

paper name:  <papername>

• The following paper name which is in either the current job or your user defaults is not in the 
catalog.  However, another paper has been found that has the same attributes.  Substituting the new 
paper name for all references to the original paper name.

paper name:  <papername>

• The following paper name which is in either the current job or your user defaults is not in the 
catalog.  References to this paper name will be replaced with the first entry in all lists containing 
paper names.  References in the Paper Exceptions pop-up will be left unchanged.

paper name:  <papername>

If you receive one of these warnings:

  1. Click the OK button on the warning box.

The Print Client Software main window appears.

  2. Pull down the File menu and select Save Print Options As <User Defaults>.

When you exit Print Client Software and start it up again, no warnings will appear.

To change user interface preferences:

 Each UNIX/OpenWindows user sets his or her own preferences.

  1. Open a command tool.

  2. Type su - <userid> and press [RETURN].

It is recommended that the root user also follow these procedures.
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Installation and Configuration
  3. The the User’s password and press [RETURN].

  4. Type /usr/srv/etc/usersetup.scl [RETURN].

  5. Start up the Print Client Software.

  6. Select the Preferences button in the Print Client Software main window.  The Preferences window  
opens

Figure 1-1  Preferences window

  7. Make the desired changes and click the Apply button.

Field Descriptions

Available features vary by selected printer.

Units—sets the units used to specify the numeric values throughout the Print Client Software interface. 
You can select inches, cm, mm, points, or centipoints as the units in which values are shown. The default 
is determined when the system is set up.

Filename(s) display as—specifies the way filenames will appear in the Filename(s) list.

Pathname(s)—the full pathnames of files dropped into the application will appear.

Filename(s)—only the filenames of files dropped into the application will appear.

Print Options—specifies which print options file is used to print the job. The default is “Individual.”

Individual—options associated with each separate document are used to print the job.

Common —options associated with the currently selected document are used to print listed 
documents. This feature allows similar documents to be printed with the same print options, 
without needing to update each individual document’s print options. For example, to print six 
documents with blue covers, duplex with three staples, set up one document, then indicate through 
the Preferences window that all  the documents should print with these options. The common print 
options feature assumes that all the documents are of the same general type. This means they must 
be the same file type (Adobe PostScript, for example), orientation, page ordering, and so forth. 
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Installation and Configuration
Printing dissimilar documents with common print options will give unexpected results.

Progress Meter Display—when checked the Progress Meter is enabled. The Meter indicates the progress 
of transmission of the print file to the destination server or printer.  

Sending File—The path of the file being transmitted.

Progress Bar—The percentage of the file that has been transmitted.

Server—Allows you to select a specific print server. You can also choose to print directly to a printer by 
selecting <None> in the Server list box. Once documents have been added to the document scrolling list, 
you cannot make any changes in the Server field.

Apply—Saves any changes you have made.

Reset—Resets all values in the window to what they were when the window was opened or the Apply 
button was last clicked.

When printing with the Progress Meter enabled, a delay of approximately one second of 
processing time is added for each document.

When attempting to print jobs to printers attached to remote servers, it is preferable to select 
the remote server by its hostname for the server preference rather than the <Local> server, 
even if the local server has queues for the remote printers.

The <Local> server may not have an accurate representation of the finishing devices avail-
able on the remote printers.
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Section 2   Overview
The Print Client Software allows you to print files from your Sun Solaris system as part of a network 
printing system. The software captures user input, builds a print request, and transfers that print request 
either directly to a specified printer or to a print server. The print server handles the print request, resulting 
in the printing of the document. Input can be received through a graphical user interface (GUI) or a 
command line interface.

You determine what documents are to be printed and how they should be processed by printers and 
finishing devices. Once a specified printer is selected you then select from a list of printing, paper, and 
page options, such as stapling, paper type, and copy count. Print options may be saved for future use.

Print Options Files

Printing and finishing options must be in place before you print your job. The options specify whether 
files should print single- or double-sided, which paper and finishing options to use, the number of 
document sets to print, and so forth. These options are stored in print options files.

Print options files are created using the Print Client Software windows. These windows, described in 
Section 4 “Print Options” and Section 5 “Paper Options”, work together to define the print options file. 

You can create several print options files, each one specifying print options for a particular type of print 
job or a specific document. For example, you might create a file for two-sided, flip on long edge format, 
stapled print jobs with blue covers, a second file for single-sided, three-hole print jobs, a third file for 
two-sided, flip on short edge format print jobs, and a fourth file for a document that has several pages 
printed on red paper.

Default Print Options Files

Print Client Software includes two special print options files:

• System default print options which are installed with the factory default options and can be 
modified by the root user.

• User default print options which are stored in the user’s file system and can be modified by the user.

When a document is added to the document list, Print Client Software must determine which print options 
to use. If the document has specific print options already assigned (that is, a .kco or ,20 file), they are 
loaded and used. When a file has both a .kco and a ,20  file, Print Client Software uses the newer of the 
two as the default options. If no .kco or ,20 file exists, the user default options are used. If the file is a 
PostScript level 2 file with Document Structuring Convention comments at the beginning of the file, these 
comments are described and used with the user default print options.

Using the File menu on the Print Client Software main window, you can apply system or user default 
print options to any file in the document list. To open system or user default print options, the document 
list must contain at least one file.

Paper Catalogs

Paper catalogs are sets of definitions for the papers that can be selected in print options files. These 
definitions associate a paper name with a size, color, weight, type, and mode (ability to be printed, printed 
one-sided,  or printed two-sided).

Paper catalogs are created using the Paper Catalog window described in Section 5 “Paper Options”. 
Instructions for opening a saved paper catalog, making changes to it, saving the changes, and saving the 
changes under a new name are included in Section 5 “Paper Options”.

The Paper Catalog window allows you to:
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• Add, modify, or delete paper definitions.

• Select a size, color, weight, mode, and type for paper definitions.

• Change the names of paper definitions.

Available Print Options

A table which indicates the options that are available for your printer can be found in Appendix D “Printer 
Specific Notes”.

Print Options and <Any> Printer Types

When the selected printer type is <Any>, you can choose any options available within the Print Client 
Software. Not all options are available on every printer. It is possible to select a combination of options 
that may not print successfully. To avoid document configurations that cannot print correctly, select your 
printer from the printer type list.
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Section 3   Printing
This chapter describes the basic steps for using Print Client Software. Also included in this chapter are 
specific examples detailing how to select print options and print under a variety of scenarios using the 
Print Client Software options described in Section 4 “Print Options” and Section 5 “Paper Options”.

Using Print Client Software

Following are the basic steps for using Print Client Software:

  1. Start up Print Client Software.

  2. Select a server.

  3. Select a paper catalog.

  4. Add jobs to the list.

• Select the following for each job in the list:

• the document file

• a printer

• print options

  5. Click the Print button.  

Opening the Main Window from the Desktop

The Print Client Software main window allows you to access windows and menus that are used to specify 
print, paper, and page options. You can access the Print Client Software main window from the 
OpenWindows desktop menu.

To open the Main window from the desktop:

To access the Print Client Software main window from the OpenWindows desktop:

  1. Place the pointer anywhere on the OpenWindows desktop.

  2. Holding down the right mouse button, select printer on the Workspace menu.

  3. Select “Print Client Software” from the printer submenu.

The Print Client Software main window opens.

Opening the Main Window from a Command Tool

You can also access the Print Client Software main window from an OpenWindows command tool.

  1. Access an OpenWindows command tool.

  2. Type /usr/srv/bin/sclient.scl & [RETURN].

The Print Client Software main window opens.

All jobs listed in the Filename(s) scrolling list are printed when you click the Print button. 
The job name does not need to be highlighted for it to print.

Multiple jobs may not print in the same order in which they appear in the Filename(s) 
scrolling list.
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Setting Up a Print Job

The following steps describe how to select print options and send the job to the printer.

  1. Start up Print Client Software.

The Print Client Software main window opens.

Figure 3-1  Print Client Software window

  2. Refer to “Selecting Preferences” on page 3-3 if you need to select a different server or modify any 
other Preferences.

  3. Refer to “Modifying Paper Catalogs” on page 3-3 if you need to change or modify the paper 
catalogs.

  4. Add jobs to print to the Filename(s) list box.

For more information about adding files, refer to “Filename(s) List Box” on page 3-5.

You can add files in several ways. One way is to use the Edit menu. Another way is to drag 
and drop one or more files onto the drop target or the Filename(s) list box in the Print Client 
Software main window.
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  5. Select a file by clicking on it in the Filename(s) list box.

  6. Refer to “Applying Print Options” on page 3-3 if you need to apply standard or default print 
options.

  7. Position the pointer over the Printer/Type menu button in the Print Client Software 
main window.

  8. Holding down the Menu mouse button, select a printer on the Printer/Type submenu.

  9. Refer to “Changing Document Print Options” on page 3-4 if you need to change any print options 
in the Print Client Software main window.

10. Refer to “Changing Document Print Options” on page 3-4 if you need to change any document 
print options.

11. Refer to “Changing Page Options” on page 3-5 if you need to change any page options.

12. Refer to “Creating Paper Exceptions” on page 3-5 if you need to create any paper exceptions.

13. Repeat step 5-step 11 for each file in the Filename(s) list box.

14. Click the Print button in the Print Client Software main window.

Jobs are sent to the printer.

Selecting Preferences

  1. Click the Preferences button in the Print Client Software main window.

  2. Make any necessary changes in the Preferences window.

  3. Click the Apply button to save any changes.

  4. Click the push pin to close the Preferences window.

Modifying Paper Catalogs

To make a temporary change to the paper catalog:

  1. Click the Catalog button in the Print Client Software main window.

  2. Make any necessary changes in the Paper Catalog window.

  3. Click the Apply button to save any changes.

  4. Click the push pin to close the Paper Catalog window.

Applying Print Options

  1. Position the pointer over the File button in the Print Client Software main window.

  2. Holding down the Menu mouse button, select “Open Print Options” on the File menu.

For more information about the Preferences window, refer to Section 1 “Installation and 
Configuration”.

The changes will remain in effect only for the current client session.

For more information about paper catalogs, refer to Section 5 “Paper Options”.
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  3. Slide to the right and select a print options file on the list of default and standard print options files 
on the Open submenu.

Changing Print Options in the Main Window

  1. Position the pointer over the File Type menu button in the Print Client Software main window. 
Holding down the Menu mouse button, select a file type on the File Type submenu.

The file type you select must match the file type of the file you are printing.

  2. Position the pointer over the Body Paper menu button in the Print Client Software 
main window. Holding down the Menu mouse button, select a paper on the Body Paper submenu.

  3. Position the pointer over the Orientation menu button in the Print Client Software 
main window. Holding down the Menu mouse button, select an orientation on the Orientation 
submenu.

  4. Position the pointer over the Job Mode menu button in the Print Client Software main window. 
Holding down the Menu mouse button, select a job mode on the Job Mode submenu.

  5. Select either the All or the Range button in the Pages field.

  6. If you selected Range, type the page numbers in the From and To fields.

  7. Type or use the increment/decrement buttons in the Copies field to enter the number of document 
sets you want to print.

  8. Select or deselect the Document Page Order check box, if necessary.

Changing Document Print Options

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “General” on the Document menu to open the General 
Options window.

  2. Make any necessary changes in the General Options window.

  3. Click the Apply button to save any changes.

  4. Click the push pin to close the General Options window.

  5. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Printer Controls” on the Document menu to open the Printer 
Controls window.

  6. Make any necessary changes in the Printer Controls window.

  7. Click the Apply button to save any changes.

  8. Click the push pin to close the Printer Controls window.

  9. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Color” on the Document menu to open the Color window.

10. Make any necessary changes in the Color window.

11. Click the Apply button to save any changes.

For more information about options on the Print Client Software main window, refer to Sec-
tion 4 “Print Options”.
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12. Click the push pin to close the Color window.

Changing Page Options

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Page Placement” on the Document menu to open the Page 
Placement Options window.

  2. Make any necessary changes in the Page Placement Options window.

  3. Click the Apply button to save any changes.

  4. Click the push pin to close the Page Placement Options window.

  5. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Background Forms” on the Document menu to open the 
Background Form Options window.

  6. Make any necessary changes in the Background Form Options window.

  7. Click the Apply button to save any changes.

  8. Click the push pin to close the Background Form Options window.

Creating Paper Exceptions

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Paper Exceptions” on the Document menu to open the Paper 
Exceptions window.

  2. Make any necessary changes in the Paper Exceptions window.

  3. Click the Apply button to save any changes.

  4. Click the push pin to close the Paper Exceptions window.

Filename(s) List Box

You can add files to print by dragging and dropping one or more files from the OpenWindows file manager 
onto the drop target or the Filename(s) list box in the Print Client Software main window. Another way 
is to use the Edit button in the Print Client Software main window to access the Edit menu. The Edit menu 
allows you to manipulate the list of files in the Filename(s) list box. You can enter pathnames and filenames 
or drop a file onto the drop target in one of the submenu windows. The Edit menu is described below.

Change—accesses a window in which you can change the selected document in the list.

Insert—accesses the Local Disk and Storage Library menus.

Local Disk—accesses the Add Document window in which you can specify the document that you 
want to add to the Filename(s) list box and where in the list it should be added.

Storage Library—accesses the Add Document From Storage Library window in which you can 
choose the document that you want to add to the Filename(s) list box and where in the list it should 
be added.

For more information about document print options, refer to Section 4 “Print Options”.

For more information about paper exceptions, refer to Section 5 “Paper Options”.
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Scanned Documents— accesses the Add Scanned Document window in which you can choose the 
document you want to add to the Filename(s) list box and where in the list it should be added.

Move—moves a selected file up or down one position in the Filename(s) list box.

Delete—removes the selected entry (or all entries) immediately from the Filename(s) list box. A 
confirmation prompt appears only if you made changes to the print options.

To add a file from the file system of your workstation:

  1. Position the pointer over the Edit button in the Print Client Software main window. Holding down 
the Menu mouse button, select Insert/Local Disk from the Edit menu.

  2. Select Bottom from the Local Disk submenu.

The Add Document to List window opens.

  3. Select a document file.

  4. Click the Apply button.

To add a file from the Network Imaging System Document Library:

  1. Position the pointer over the Edit button in the Print Client Software main window. Holding down 
the Menu mouse button, select Insert/Storage Library from the Edit menu.

  2. Select Bottom from the Storage Library submenu.

The Add Document From Storage Library window opens.

  3. Browse through the library by selecting “Folders” in the Folders list.

  4. Select a document file from the Files list.

  5. Click the Apply button.

To add a TIFF document from the file system of your workstation:

This procedure can be used to print directories of single page TIFF CCITT Group IV compressed image 
files. The directory itself is considered a “TIFF document.” The pages will be printed in alpha numeric 
order of the TIFF filename in the directory.

  1. Position the pointer over the Edit button in the Print Client Software main window. Holding down 
the Menu mouse button, select Insert from the Edit menu..

  2. Select Storage Library if the TIFF document is in Network Imaging System Document Library 

or

Select Scanned Document if the TIFF document is elsewhere in the file system of the SCS 
Workstation.

  3. Select “Bottom” from the Scanned Document submenu.

The Add Document window opens.

To select a document file, drag a file icon from the file manager and drop it onto the drop 
target or type the document’s pathname and filename in the Directory and File text entry 
fields.
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  4. Browse through the file system by selecting “Directories” in the Folders list.

  5. Select a document from the Documents list.

  6. Click the Apply button.

To change a file:

  1. Select a file in the Filename(s) list box in the Print Client Software main window by clicking it.

  2. Position the pointer over the Edit button. Holding down the Menu mouse button, select Change 
from the Edit menu.

The Change Document in List window opens.

  3. Select a document file.

  4. Click the Apply button.

To move a file:

You can move a selected file up or down in the Filename(s) list box in the Print Client Software main 
window.

  1. Select a file in the Filename(s) list box in the Print Client Software main window by clicking it.

  2. Position the pointer over the Edit button. Holding down the Menu mouse button, select Move from 
the Edit menu.

  3. Slide the pointer to the right and select Up or Down from the Move submenu.

The file is moved up or down one line in the Filename(s) list box.

To delete a selected file in the Filename(s) list box:

You can select the file to be deleted from the Filename(s) list box in the Print Client Software main window 
or delete all files at one time.

  1. Select a file in the Filename(s) list box in the Print Client Software main window by clicking it.

  2. Position the pointer over the Edit button. Holding down the Menu mouse button, select Delete from 
the Edit menu.

  3. Slide the pointer to the right and select Selected from the Delete submenu.

When browsing the file system, there may be delays in updating the Directories and Docu-
ments lists while each directory is scanned for TIFF documents.

When using the Scanned Documents browser, the names listed in the Documents list are 
actually the names of any directories that have TIFF files in them. In order to be identified 
as TIFF files, the filenames must contain .tif, .r300, or .r600 somewhere in the name.

To select a document file, drag a file icon and drop it onto the drop target or type the docu-
ment’s pathname and filename in the Directory and File text entry fields.
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The selected file is deleted.

To delete all files in the Filename(s) list box:

  1. Position the pointer over the Edit button in the Print Client Software main window. Holding down 
the Menu mouse button, select Delete from the Edit menu. 

  2. Slide the pointer to the right and select All from the Delete submenu.

All of the files in the Filename(s) list box are deleted.

Printing Using the Default Settings

To print using the default print options:

  1. Add files to print to the Filename(s) list box on the Print Client Software main window.

  2. Select a file from the Filename(s) list box by clicking it.

  3. Position the pointer over the File button in the Print Client Software main window. Holding down 
the Menu mouse button, select Open Print Options from the File menu.

  4. Slide the pointer to the right and select <User Defaults> from the Open submenu.

The default user print options file becomes the current print options file.

  5. Click the Print button in the Print Client Software main window.

The job is sent to the printer specified in the user default print options file.

Printing a Two-sided, Stapled Document with Covers

To print a two-sided, stapled, document with front and back covers:

  1. Add files to print to the Filename(s) list box in the Print Client main window.

  2. Select a file by clicking on it in the Filename(s) list box.

  3. Position the pointer over the Job Mode menu button. Holding down the Menu mouse button, select 
Duplex from the Job Mode submenu.

To specify stapling:

  1. Position the pointer over the Device menu button in the Finishing Options window.

If you made changes to the print options, a confirmation prompt appears.

You do not need to select the file(s) in the Filename(s) list box.

If you made changes to the print options for any of the documents in the list, a confirmation 
prompt appears. Only one prompt appears, even if you made changes to the print options of 
several documents.
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  2. Holding down the Menu mouse button, select Finisher on the Device submenu.

  3. Position the pointer over the Stapling menu button in the Finishing Options window. Holding down 
the Menu mouse button, select Top from the Stapling submenu.

To specify covers:

  1. Position the pointer over the Front Cover menu button. Holding down the Menu mouse button, 
select Print Both Sides on the Cover submenu.

  2. Position the pointer over the Front Cover Paper menu button. Holding down the Menu mouse 
button, select a paper from the Paper submenu.

  3. Repeat step 1 and step 2 for the Back Cover.

The Paper Exceptions window closes.

To print the document:

Click the Print button in the Print Client Software main window.

Printing Without Status Pages

To print a document so status pages are not printed:

  1. Start up Print Client Software.

The Print Client Software main window opens.

  2. Add files to print to the Filename(s) list box.

  3. Select a file by clicking on it in the Filename(s) list box.To deselect the Status Page control:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select Printer Controls from the Document menu.

The options available on this submenu depend on the selected printer type.

The options available on this submenu depend on the selected printer type and device.
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The Printer Controls window opens.

Figure 3-2  Print Controls window

  2. Position the pointer over the Status Page menu button in the Printer Controls window. Holding 
down the Menu mouse button, select None from the Status Page menu.

  3. Click the Apply button in the Printer Controls window.

The changes are saved.

  4. Click the push pin to close the Printer Controls window.

To print the document:

Click the Print button in the Print Client Software main window.
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Printing Using “Common” Print Options

Printing files with “Common” print options allows you to print each document in the list using the currently 
displayed print options.

To use “Common” print options, open the Preferences window and choose “Print Options:  Common”.

Adding Files and Changing Print Options

You can add files in several ways. One way is to use the Edit menu to enter pathnames and filenames. 
Another way is to drop one or more files onto the drop target or the Filename(s) list box in the Print Client 
Software main window.

To add files and change print options:

  1. Add files to print to the Filename(s) list box.

  2. Select a file that has the print options you want to use for all of the files in the Filename(s) list box.

Deleting the Document after Printing

Select the appropriate delete option from the Edit pulldown menu to delete the file from the Print Client 
Software main window.

For more information about the Preferences window, refer to Section 1 “Installation and 
Configuration”.
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Section 4   Print Options
This chapter discusses the following windows:

• Print Client Software main window

• General Options

• Printer Controls

• Color

Print Client Software Main Window

From the Print Client Software main window you can select print options, access submenus for page 
placement options and paper catalogs, and send the selected document to the selected printer.

Open the Print Client Software main window by placing the mouse pointer anywhere on the OpenWindows 
desktop and, holding down the Menu mouse button, select “Printer” on the Workspace menu. Select “Print 
Client Software” from the printer submenu. 

The Print Client Software main window opens.

Figure 4-1  Print Client Software window

You also can access the Print Client Software main window
from an OpenWindows command tool. Type:
/usr/srv/bin/sclient.scl & [RETURN] at the command line prompt.
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Field Descriptions

Available features vary by related printer.

File—accesses a menu that allows you to save and/or restore sets of print conditions.

Open Print Options—accesses a menu from which you can select an existing print options file.

Save Print Options—saves print options for the selected document to the document’s print options 
file.

Save Print Options As—accesses a menu from which you can define a new print options file name 
and save the print options to it.

About—accesses a window that contains information about Print Client Software.

Exit Application—exits Print Client Software.   

Document—accesses a menu that allows you to select document configuration and printer 
control windows.

General—accesses the General Options window, which allows you to change general-purpose 
settings, such as charge number, destination, and operator messages.

Paper Exceptions—accesses the Paper Exceptions window, which allows you to specify, on a 
page-by-page basis, pages within the document that should be printed on different kinds of paper.

Printer Controls—accesses the Printer Controls window, which allows you to specify features 
such as printing header and/or status pages.

Color—accesses the Color window, which allows you to customize the mapping of color 
components to toners installed.   

Catalog—accesses the Paper Catalog window.  

Preferences—accesses the Preferences window. 

Print—executes the print request and sends the job to the printer and/or stores the job on the Network 
Imaging System print server.

“Open Print Options” and “Save Print Options” are not available unless files are listed in 
the Filename(s) list box.

For information about the General Options, Printer Controls, and Color windows, refer to 
the respective sections in this chapter. The Paper Exceptions window is described in Section 
5 “Paper Options”. 

For information about the Paper Catalog window, refer Section 5 “Paper Options”

For information about the Preferences window, refer to Section 1 “Installation and Configu-
ration” and Section 3 “Printing”.
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Edit—accesses a menu that allows you to manipulate the list of files in the Filename(s) scrolling list. 

Printer/Type—allows you to select from the available printers on which you want your output printed.

If <Any> is selected, the server designated in the Preferences window selects the printer that will process 
the print request. 

Filename(s)—displays the file(s) for the current print job. One file can be selected at a time, and the 
settings for that file are represented in the main window and any associated windows and submenus. 
Depending on the setting in the Preferences window, filenames appear as simple filenames or full 
pathnames.

Use one of the following methods to enter filenames to the scrolling list:

• Drag one or more file icons from File Manager and drop onto the drop target at the left of the 
Filename(s) field or into the Filename(s) list box.

• Use the Edit button to change or insert a file. Filename(s) and pathname(s) that exceed the width of 
the scrolling list are left-justified and truncated in appearance only. To view the filenames of names 
that exceed the width of the Filename(s) box, access the Preferences window and choose 
“Filename(s) display as” Filename(s).

• Specify filename(s) on the command line when launching the graphical user interface (GUI) 
version of Print Client Software to allow the file and its options to appear in the GUI document 
scrolling list. 

File Type—allows you to specify an emulation file type, based on the selected printer type. Refer to 
Appendix D “Printer Specific Notes” for more information

In most cases, when files are loaded into the file list, the Client will detect the file type.  In cases where 
the Client cannot detect the file type, the user default file type will be used.  After loading a file into the 
list, verify that the file type setting  is correct before proceeding.

For information about the Edit menu, refer to “Filename(s) List Box” on page 3-5.

The <Any> entries do not appear when you select <None> for the Server in the Preferences 
window. There is no server involved to select the actual printer to which the job is sent.

PCL language jobs are not standardized. As a result, you may encounter problems if you try 
to send a PCL language job to a printer type of <Any>. Instead, select a specific printer 
type.

For example, type sclient.scl taxes.ps forms.ps [RETURN].

When the Print Client Software main window opens, taxes.ps and forms.ps appear in the 
Filename(s) list box.

If the File Type is set incorrectly, jobs may not print as expected. When using the Print Cli-
ent for modifying the options of jobs in the Network Imaging System print server queues, 
changing the File Type may yield unexpected results.
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Body Paper—allows you to select the paper to use. 

Orientation—allows you to specify how logical page images are presented.

Default—no page image manipulation occurs.

Portrait—the page image is vertically oriented.

Landscape—the page image is horizontally oriented. 

 Job Mode—sets the printing style for the body of the document. The default is Simplex.

Simplex—output is printed on one side of the paper. 

Duplex—output is printed on both sides of the paper.  

Pamphlet—output is printed so sets can be saddle-folded (folded in half) and formatted as a book. 
Blank pages are added by the printer at the end of the document to make an even multiple of four 
pages.

The same document may print differently for different users if their emulation_options files 
have different specifications.

PCL language jobs are not standardized. As a result, you may encounter problems if you try 
to send a PCL language job to a printer type of <Any> printer. Instead, select a specific 
printer.

Directories for TIFF CCITT Group IV compressed image files can be printed using the 
KGL Emulation Type. See “To add a TIFF document from the file system of your worksta-
tion:” on page 3-6.

For more information about defining new papers, refer to Section 5 “Paper Options”.

The Orientation field is not selectable for all printers. This is because information embed-
ded in the page description language (Adobe PostScript, PCL5) overrides the selection in 
this field in documents where each logical page is mapped to a physical page.

The two orientations interact as shown below:

In grids of 1 by 1 (that is, each logical page is mapped to a physical page), the physical and 
logical orientations must match.

When the Job Mode is “Duplex” and the Body Paper is “Mode: 1-Sided,” the software over-
rides the Job Mode to be consistent with the paper request.

Orientation (main window)

Sheet Orientation (Page Placement window)

1

2
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They will be counted as part of the maximum pamphlet size. For example, if Preprinted/Blank is 
selected as the Front Cover option this cover would be counted as one sheet of the pamphlet.  

Interleaves—a sheet of regular paper (printed or non-printed) is inserted between  pages. The body 
paper selection determines the interleaves material. When you select this job mode, values entered 
in the Paper Exceptions window are ignored. A common use for interleaves is to separate sheets 
when printing on transparency material.   

Copies—sets the number of document sets (copies) to be printed. See Appendix D “Printer Specific 
Notes” for more information.

Collated Copies—when checked, multiple sets of a print job should be delivered collated (as sets)  into 
the exit bin. Collation means that all pages of one set are printed before any pages for the next set are 
printed.

For example, if you request three sets of a four-page job and the Collated Copies check box is selected, 
three sets of pages 1 through 4 print. If the check box is not selected, the requested number of each page 
are printed as a separate set (for example, three sets of page 1, three sets of page 2, three sets of page 3, 
and three sets of page 4).

The following example shows three sets of a four-page document with and without collation. 

Figure 4-2  Example of collated and non-collated documents

Pages—allows you to specify whether all or only a portion of the document is to be printed. When “All” 
is selected, the entire document is printed. The default is All.

To print only certain pages of a document, select “Range.” Type the number of the first page to be printed 
in the From field, and the number of the last page to be printed in the To field. (To print only one page, 
type the same number in both the From and To fields.) 

Document Page Order—when checked, allows you to select the page order in which a document was 
created by a document composition application. If the check box is not checked, the document is in “First 
page first” order.  This control only applies to TIFF documents.  For more information see“To add a TIFF 
document from the file system of your workstation:” on page 3-6. 

The Job Mode duplex setting will be overridden and printed simplex if the “Mode: 1-Sided” 
parameter is set for the selected body paper in the paper catalog.

The “Mode: 1-sided” paper attribute is ignored (if specified) when Pamphlet is selected in 
the Job Mode field.

The selection in the Job Mode field may be overridden by commands in the print file when 
PostScript level 2 or 3 files are printed.

The selection in the Collated Copies field may be overridden by commands in the print file 
when PostScript level 2 files are printed.
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Rotation—option will allow you to rotate images 0, 90, 180 or 270 degrees.  The rotation applies to all 
images in the document.

Covers

Front Cover—accesses a menu that allows you to specify how covers will be applied to the document.

None—no cover is applied and the associated paper list is disabled.

Print Side 1—prints a simplex cover on the selected paper.

Print Side 2—prints on the back of the cover page of the selected paper, leaving the front blank.

Print Both Sides—prints on both sides of the selected paper. 

Preprinted/Blank—the selected paper is used and with no image from the document printed on it.

Front Cover Paper—allows you to specify the paper to be used for the Front Cover.

Back Cover—accesses a menu that allows you to specify how covers will be applied to the document.

None—no cover is applied and the associated paper list is disabled.

Print Side 1—prints a simplex cover on the selected paper.

Print Side 2—prints on the back of the cover page of the selected paper, leaving the front blank.

Print Both Sides—prints on both sides of the selected paper. 

Preprinted/Blank—the selected paper is used and with no image from the document printed on it.

Back Cover Paper—allows you to specify the paper to be used for the Back Cover.

Finishing Device—allows you to select an output device for your job. Different options are available 
depending on the selected printer type.

Stacking—allows you to specify if multiple sets of a document are delivered with or without a shift 
between sets.  

Offset—finished sets are delivered in a stack with each set shifted slightly.

Straight—finished sets are delivered in a single stack. 

Different cover options will be available depending upon the printer type selected. Refer to 
your printer’s user guide for information on available options.

The Cover “sides to print” selections “Print Side 2” and “Print Both Sides” will be overrid-
den and printed simplex (Print Side 1) if the “Mode: 1-Sided” parameter is set for the 
selected cover paper in the paper catalog.

The Cover “sides to print” selections “Print Side 2” and “Print Both Sides” will be overrid-
den and printed simplex (Print Side 1) if the “Mode: 1-Sided” parameter is set for the 
selected cover paper in the paper catalog.

The selection in the Stacking field may be overridden by commands in the print file when  
PostScript level 2 or 3 files are printed.
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Figure 4-3  Example of offset and straight stacking

Stapling—allows you to specify if (and where) printed sets are stapled. Different options  are available 
depending on the selected printer type. 

None—the document is not stapled.

Top—a portrait document is stapled in the upper left corner.

Bottom—a landscape document is stapled in the upper left corner.

2 Left Edge—a portrait document is stapled near the upper left and lower left edge.

3 Left Edge—a portrait document is stapled near the upper left, center left, and lower left edge.

Saddle Stitch—a folded landscape document (usually a pamphlet) has staples in the upper and 
lower center.  

Figure 4-4  Examples of stapling

When you print a landscape job, selecting “Bottom” in the Stapling field generally gives you the correct 
results. However, not all software applications orient landscape documents in the same way. When the 
printer receives the document, it knows that a job is to print in landscape mode, but it does not know the 
orientation of the top and bottom of the images. It cannot automatically rotate the image to make up for 
the variations among software applications. Sometimes, your printing results may not be desirable.

The selection in the Stapling field may be overridden by commands in the print file when 
PostScript level 2 or 3 files are printed.

The finishing device attached to your printer has a maximum pamphlet size that it can han-
dle. Refer to Appendix D “Printer Specific Notes” for more information.

front
cover

front
cover

None Top Bottom

front
cover
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Figure 4-5  Examples of undesirable stapling

Folding—allows you to specify if (and how) printed sets are folded.  

None—the output is not folded.

Saddle Fold—the output is folded in half to be stapled (saddle stitched). This setting is useful 
when you are creating pamphlets. 

Z-fold—the output is folded in accordion folds.

Figure 4-6  Examples of folding  

Opening a Print Options File  

  1. Position the pointer over the File button in the Print Client Software main window. Holding down 
the Menu mouse button, select Open Print Options from the File menu.

The options available depend on the printer type chosen.

The selection in the Folding field may be overridden by commands in the print file when 
PostScript Level 2 or 3 files are printed.

Do not attempt to saddlefold more than the maximum number of sheets for your printer.

Only 11 x 17-inch and A3 paper sizes can be used for z-folding. For more information about 
z-folding, refer to your printer’s user’s guide.

This feature is not available on the Network Imaging System.

Opening a print options file is possible only when a file is in the file list.

Long-edge-fed, Bottom Staple

Expected Result Possible Result

front
cover

front
cover
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  2. Slide the pointer to the right and select a print options file from the Open submenu.

The options in the selected print options file become the current print options.

or

If you selected Other on the Open submenu, make any necessary changes in the Open Print Options 
window.

  3. Click the Select mouse button on the Apply button in the Open Print Options window.

The selections on the Open menu are described below. 

<User Defaults>—opens the user default print options file.

<System Defaults>—opens the system default print options file.

Other—accesses a window to specify an options file to open..

Drag a stored print options file from the File Manager and drop it onto the drop target (the rectangle in 
the upper left corner), the Filename(s) list box, or type the name of a directory and file in the text fields. 
Click the Apply button. The selected print options file becomes the current print options file.

Saving Print Options

To save document print options:

  1. Position the pointer over the File button in the Print Client Software main window. Holding down 
the Menu mouse button, select Save Print Options from the File menu.

  2. Slide to the right and make a selection from the submenu.

The following selections are available on the Save Print Options submenu.

Selected—saves the print options for the selected file to its associated print options 
(.kco) file.

All—saves the print options for all of the files listed in the file list box to their associated print options 
(.kco) files.  

To save default print options:

  1. Position the pointer over the File button in the Print Client Software main window. Holding down 
the Menu mouse button, select Save Print Options As from the File menu.

  2. Slide to the right and select a print options file on the Save As submenu.

If you selected Standard Print Options or Other on the Save As submenu, make any necessary 
changes in the Save as Standard Print Options or Save As Other Print Options windows.

  3. Click the Apply button in the Save As Standard Print Options or Save As Other Print 
Options window.

The following selections are available on the Save As menu.

Any print options names that previously have been saved appear on the Open submenu.

To save default options for a scanned document from the Scanned Document Browser, there 
must be a scanned document in the client file list and it must be selected.
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<User Defaults>—saves the displayed print options as the user default print options file.

Standard Print Options—accesses a window similar to choose a standard options file.  

Click the print options file you want to select, or type the file name in the text field. Click the Apply 
button. The selected print options are saved under the specified name and appear in the Open Print 
Options submenu.

Other—Type the name of a directory and file in the text fields, then click the  Apply button. The 
print options are saved in the specified directory and file.

The <System Defaults> print options file is available to root users only.
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General Options

The General Options window allows you to select some general-purpose settings.

To open the General Options window:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select General from the Document menu.

The General Options window opens.

Figure 4-7  General Options window

Field Descriptions

Available features vary by selected printer.

User Id—allows you to change the user identification on the job header page and in accounting 
information.

The number of characters allowed in this field varies by printer type. Valid characters 
include spaces, numbers 0 through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters 
(144–255 ASCII), and the following characters: ! @ # $ % – _ + = : ; , . 

Charge Number—allows you to enter a charge number for accounting purposes.

Blank spaces at the end of a text string are considered part of that string.
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Up to 31 characters may be entered in the Charge Number text field. Valid characters include spaces, 
numbers 0 through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters (144–255 
ASCII), and the following characters: ! @ # $ % – _ + = : ; , . 

Destination—allows you to specify if the file is sent directly to the printer, stored as a resource on the 
print server, or both. The default is “Printer.”

Printer—specifies the printer you want to use.

Server File—requests that the job be saved on the Network Imaging System print server. You must 
specify the name of the file or some unique identifier in the Document Name field.  The system 
print server will store the document into the system Document Library or the print server’s 
Resource Manager, depending upon the server’s configuration.

Document Name—allows you to specify the name of the file to be saved on the print server.

Up to 99 characters may be entered in the Server Filename text field. Valid characters include 
spaces, numbers 0 through 9, all lowercase and uppercase letters
(a–z, A–Z), diacritical characters (144–255 ASCII), and the following characters: 
! @ # $ % – _ + = : ; , .

Create TIFF—creates a TIFF file and save the file to the Document Library.

Document Name—allows you to specify the name of the TIFF file before it is stored in the 
Document Library. 

Up to 99 characters may be entered in the Server Filename text field. Valid characters include 
spaces, numbers 0 through 9, all lowercase and uppercase letters
(a–z, A–Z), diacritical characters (144–255 ASCII), and the following characters: 
! @ # $ % – _ + = : ; , .

Blank spaces at the end of a text string are considered part of that string.

Multiple jobs may not print in the same order in which they appear in the Filename(s) 
scrolling list.

When Destination “Server File” is selected documents will be stored in the “Server” folder 
Network Imaging System of the Document Library in a folder named for the Client User ID 
from the User ID field.  If no User ID is specified, the document is stored in a folder named 
“unknown_user”.

The TIFF documents will be stored in the “RIP” folder in a folder named for the Client User 
ID from the User ID field.  If no User ID is specified, the document is stored in a folder 
named “unknown_user”.
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Operator Message—allows you to enter a message to be printed on the job’s header page (for example, 
“This is a RUSH job” or “Use letterhead paper”). This text may appear on the printer console menu while 
the job is processing and printing, depending on which printer type was selected. The number of characters 
allowed in this field varies by printer type. Valid characters include spaces, numbers 0 through 9, all 
lowercase and uppercase letters (a–z, A–Z), diacritical characters (144–255 ASCII), and the following 
characters:
! @ # $ % – _ + = : ; , . 

Deliver To—allows you to enter a name or message of up to 31 characters that will appear on a status 
page (if a status page is requested).  This message can be used to tell an operator at the printer where to 
forward a job. 

Email To—allows you to enter an e-mail address of up to 63 characters. If a Status Page has been requested, 
the status page information will be e-mailed to the addressee once the job has been processed.. 

Apply—saves any changes you have made.

Reset—resets all values in the window to what they were when the window was opened or when the 
Apply button was last clicked.

Blank spaces at the end of a text string are considered part of that string.

With some printer types, the job will be paused and not printed until an operator responds to 
the message.

Blank spaces at the end of a text string are considered part of that string.
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Printer Controls

The Printer Controls window allows you to specify special features beyond those required for normal 
printing. Some of these features affect the output only when options from other menus are selected.

To open the Printer Controls window:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select Printer Controls from the 
Document menu.

The Printer Controls window opens.

Figure 4-8  Printer Controls window

Field Descriptions

Paper Mismatch Handling—the action the printer will take if a specified paper, stacking, and/or stapling 
option does not match the option displayed on the printer console.   

Maximum Pamphlet Size—allows you to specify the maximum size of your pamphlet. You also can 
use this field to break up a large job into multiple smaller pamphlets that can be bound together to make 
a book.

The size value is the number of sheets.  Normally, this should be a number greater than the number of 
pages in the document, divided by 4.
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“Pamphlet” must be selected in the Job Mode field in the Print Client Software main window. If you select 
“Other” from the menu, the Maximum Pamphlet Size window opens, allowing you to specify the number 
of sheets.

The maximum number of pages is printer-dependent.

Pamphlet Fold Direction—allows you to specify how pamphlets are folded.

Trim—when checked, pamphlets folded by the system booklet maker are trimmed to eliminate uneven 
edges.

Two Sided Format—contains two selectable icons that allow you to specify if two-sided jobs should be 
printed in barrel (Flip on Long Edge) or tumble (Flip on Short Edge) format.

Long Edge—two-sided jobs are printed so the top of each image is oriented to the same edge of the 
paper. This may be useful if pages are bound on a side edge. Flip on Long Edge printing also is 
known as book or barrel duplex printing.

Short Edge—two-sided jobs are printed so the top of each image is oriented to opposite edges of 
the paper. This may be useful if pages are to be bound on a top or bottom edge. Flip on Short Edge 
printing also is known as calendar or tumble duplex printing.

Interleaves—contains two selectable icons that allow you to specify if interleaves between transparencies 
are printed.

Printed—interleaves will be printed with the image printed on the corresponding 
transparency page.

Blank—interleaves are not printed.

Interleave Paper—allows you to choose a paper from the current paper catalog for the transparency 
interleaves.

Set Separators—when checked, document sets are delivered with a blank sheet of paper between sets 
when multiple sets are requested. Using separators provides easy retrieval of document sets and is an 
alternative to offset stacking. If the check box is selected, a finished job has separator sheets between 
sets.Example of set separators

When setting the maximum pamphlet size, take into account the effect of preprinted or 
blank covers, if selected.  They will be counted as part of the maximum pamphlet size. For 
example, if Preprinted/Blank is selected as the Front Cover option this cover would be 
counted as one sheet of the pamphlet.

Finishing devices limit the number of sheets that they can fold and staple.  Refer to Appen-
dix D Printer Specific Notes, to find the value permitted by your finishing device.

Separators will not be added to a job when Stapling is selected.

set

set
separators

3

2

1

With separators
set

3

2

1

Without separators
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Paper—allows you to choose a paper from the current catalog for the set separator sheets. 

Apply—saves any changes you have made.

Reset—resets all values in the window to what they were when the window was opened or the Apply 
button was last clicked.

Status Page—specifies when a status page is to be printed for each job.

None—no status page is printed.

Always—a status page is always printed for each job.

Always – 1st Page Only—only the first of the status pages prints. 

Only On Error—a status page is printed only when an error occurs during printing.

Paper—subfields allow you to choose a paper for job header and status pages. 

Proof Set—when checked, the system will print one copy of the job so you can review it before printing 
all of the copies.

Compile Only – Do Not Print—when checked, the system processes the job without
printing it. 

Custom Printer Commands—allows you to type special commands to be sent with the print job. 
Alternately, you can type the name of a file containing print commands in the text box. The commands 
must be in the form of DSC (Document Structuring Convention) comments or KDK extensions. This is 
a way to request special options not available in the menus. An error in this field results in an error at the 
printer or print server.  

Apply—saves any changes you have made.

Reset—resets all values in the window to what they were when the window was opened or the Apply 
button was last clicked.

For information about defining new papers, refer to Section 5 “Paper Options”.

For more information about defining new papers, refer to Section 5 “Paper Options”.

When you select the Compile Only – Do Not Print check box and save the print options, the 
selected Compile Only – Do Not Print option is saved with the print options file. If you 
want to recall and print the job, you must deselect the Compile Only – Do Not Print check 
box.

Since the document will not be printed, you should specify "Always" in the Status Page 
field so you can view the processing results.

If a file name is found in the first line in the Custom Printer Commands text box, it is used. 
Any other entries in the Custom Printer Commands text box will be ignored.

For more information about custom printer commands, contact your software support pro-
vider.
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Color

This feature is not available on the Network Imaging System.
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Section 5   Paper Options
This chapter discusses the following windows:

• Paper Exceptions

• Paper Catalog

Paper Exceptions

The Paper Exceptions window allows you to create a list of document page ranges that should print on 
paper other than the body paper. The job is printed on the paper previously specified in the Body Paper 
field, except for those pages specified in this menu. If the Paper Exceptions menu is empty, the entire job 
is printed on the body paper specified in the Body Paper field.

To open the Paper Exceptions window:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select Paper Exceptions from the Document menu.

The Paper Exceptions window opens.

Figure 5-1  Paper Exceptions window

Paper Exceptions will be ignored if the Interleaves Job Mode is selected for the job.
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Field Descriptions

Paper—indicates the paper that should be used for the indicated pages. A description of the currently 
selected paper appears in the box in the lower left area of the window. 

Exception Mode—allows you to select a printing style for the paper exception. The default is <Job 
Mode>.

The Exception Mode selection has no effect when the Exception Paper is <New Chapter>.

<Job Mode>—the paper exception follows the mode of the main body.

Simplex—output is printed on one side.

Duplex—output is printed on both sides. 

Page List—lists the page(s) where specified paper types are to be used in the document. Page ranges can 
be expressed as two numbers separated by any number of periods. For example, to express the page range 
“45 to 52,” you can type 45.52 or 45............52 in the Page List text field. Multiple page ranges can be 
specified as long as each one is separated by a comma.

The syntax for the Page List text field is described in the following table. Page numbers refer to the actual 
pages and may not relate to the document page numbers.   

Table 5-1  Syntax examples

The paper selection “<New Chapter>” causes each page in the page list to be printed on 
the front of a sheet. This affects only duplex jobs. The <New Chapter> paper exception 
can also be used to accomplish subset finishing when used in conjunction with the New 
Chapter Finish Separately control described on page 5-3.

The Exception Mode will be overridden and printed simplex if the “Forced One-Sided” 
parameter is set for the Exception Paper in the paper catalog.

The Page List text field will accept a maximum of 256 characters.

Once a paper exception page list has been added to the Exception list box, the entire Page 
List may not be visible. To view a long Page List, left-click on the Exception. The Page List 
for the Exception will be displayed in the Page List field at the top of the window.

Syntax Definition Example

n A specific page number 45

n...n A range of pages 45...52

n,n More than one page number 45,52

^n Insert a blank page before the specified page ^45

n^ Insert a blank page after the specified page 45^

n... A range starting at the specified page and continuing through the final page 45...

...n A range starting at the first page and continuing through the specified page ...45

1... All pages 1...
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If you create more than one exception for a particular page or range of pages, the paper specified by the 
exception highest in the list of paper exceptions is used. All other papers specified for that page or range 
of pages are ignored. Page ranges before and after a page, as well as substitutions for a page, are handled 
independently, and do not override each other (for example, an entry of “^2,^3,^4” will not override 
“2^,3^,4^” or “2,3,4”).

If an entry has a paper specification but no entry in the Page List text field, it is ignored. 

Slip sheets are supported with Pamphlet Mode when the page selected for this exception is the first image 
on the sheet. In this instance, <Job Mode> should be selected for the Exception Mode. As a note, other 
exception modes can be selected, but the job will always print in Pamphlet Mode.

Inserts are not supported with pamphlets.

Paper Exception Examples

Following are some examples of how page list entries are interpreted.

• If you want blank blue pages to be inserted before sections that begin on pages 3, 10, and 22, select 
“blue-11" in the Paper field and type  ^3, ^10, ^22  in the Page List field.

• If you want pages 15 through 25 to print on transparency material, select “transparency” in the 
Paper field and type  15...25  in the Page List field. 

New Chapter Finish Separately—when checked, indicates that each chapter entered as a <New Chapter> 
paper exception will be finished separately using the job finishing 
feature selections.

Edit—accesses a menu that allows you to manipulate the selected paper exception entry.

Update—changes the currently selected line in the paper list box with the values entered in the 
Paper and Page List fields.

Insert—creates a new line in the paper list and adds the selected paper type and page list value to 
the paper list. The Insert submenu allows you to select where in the page list box the specified entry 
should be placed.

Move—moves a selected paper list entry up or down one position on the list.

Delete—removes the selected entry (or all entries) from the paper list.

If the “1...” or “n...” syntax is used, you are prompted for the number of pages in the docu-
ment. If you do not enter the correct page count, unexpected results may occur.

The page numbers used in the Page List field refer to the sequence of page images as they 
are delivered to the printer. These numbers do not necessarily correspond to the page num-
bers assigned within the application that created the document.

You may need to experiment when trying to print the final page on alternate paper. The best 
method is to enter the actual page number for the final page.

If the paper you want to use for a paper exception is not listed in the Paper field, use the 
“Other” option to add the paper to the paper catalog. For more information, refer to “Paper 
Catalog Window” in this chapter.

The selections for inserts, slip sheets, and chapters may be overridden by commands in the 
print file when PostScript language files are printed.
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Apply—saves any changes you have made.

Reset—resets all values in the window to what they were when the window was opened or the Apply 
button was last clicked.

Paper Exception Entries

To add a Paper Exception entry:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select “Paper Exceptions” on the Document menu.

The Paper Exceptions window opens.

  2. Select the paper in the Paper field that you want to use for the exception.

  3. Select the Exception Mode that you want to use for the Exception.

  4. Type the pages or page range in the Page List text field.

  5. Position the pointer over the Edit button in the Paper Exceptions window. Holding down the Menu 
mouse button, select Insert from the Edit menu.

  6. Slide to the right and select a placement selection on the submenu.

The paper exception entry appears in the paper list box.

  7. Click the Apply button in the Paper Exceptions window.

Any changes are saved.

To delete a Paper Exception entry:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select Paper Exceptions from the Document menu.

The Paper Exceptions window opens.

  2. Select the paper exception to be deleted from the list box.

  3. Position the pointer over the Edit button in the Paper Exceptions window. Holding down the Menu 
mouse button, select Delete from the Edit menu.

  4. Slide the pointer to the right and choose Selected from the submenu. 

The paper exception entry is deleted.

  5. Click the Apply button in the Paper Exceptions window.

Any changes are saved.

Paper Catalog Window

This window allows you to create one-time paper definitions beyond those in the list of predefined papers 
or to permanently add a paper to the catalog.

If you want to delete all of the paper exception entries, choose “All” on the Delete submenu.
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Not all paper definitions are compatible with all printers. Ensure that you use paper parameters that are 
compatible with the printers to which print requests are being sent. 

To open the Paper Catalog window:

Select “Other” on the Body Paper menu or any other menu that contains a list of papers, or click the 
Catalog button in the Print Client Software main window to open the  Paper Catalog window.

Figure 5-2  Paper Catalog window

Field Descriptions

File—allows you to open, save, or delete a paper catalog. 

Open Paper Catalog—accesses a window in which you can select an existing paper catalog to 
become the current paper catalog. 

The system administrator may disable the capability to add new papers to the catalog.

Selecting “Other” in the Body Paper menu or any other paper list menu will access the 
Paper Catalog window. However, changes made in the Paper Catalog window when adding 
a new paper are not automatically selected for body paper or another paper list.

This option is available only if the file list box is empty.
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Save Paper Catalog—saves the current paper definitions to the current paper catalog.

Save Paper Catalog As—accesses a window in which you can save the current paper definitions 
to a catalog under a different name.

Delete Paper Catalog—deletes the selected paper catalog. 

Edit—accesses the Edit menu, allowing you to create, rename, and delete paper definitions. 

New Definition—accesses a window in which you can create and name a new paper definition 
from a copy of the current paper definition.

Up to 10 characters may be entered in the text field. Valid characters include spaces, numbers 0 
through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters (144–255 ASCII), 
and the following characters:  @ # $ % – _ + = : ; , .

Rename—accesses a window in which you can rename the current paper definition.

Up to 10 characters may be entered in the text field. Valid characters include spaces, numbers 0 
through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters (144–255 ASCII), 
and the following characters:  @ # $ % – _ + = : ; , .

Delete—deletes the currently selected paper definition.

Paper—allows you to select a paper for the current paper definition.

Size—allows you to select a paper size for the current paper definition.

Color—allows you to select a color for the current paper definition. When <Any> is selected, jobs are 
printed on the available paper, regardless of color.

In certain situations, both the Color choices “*” and <*> may appear on the color choice list. If a paper 
with Color <*> is defined and used, the printer receiving the job will use a paper which best matches the 
other parameters in the paper definition, ignoring the color. If a paper with color “any” is defined and 
used, the printer will only use a paper that has a color parameter that is the word, “any.” 

If you select Other, the Other Paper Colors window opens.

Up to 19 characters may be entered in the text field. Valid characters include spaces, numbers 
0 through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters (144–255 ASCII), and 
the following characters: ! @ # $ % – _ + = : ; , . 

Weight—allows you to select a paper weight for the current paper definition. When <Any> is selected, 
jobs are printed on the available paper, regardless of weight. 

The Weight menu contains various industry standards for common paper weights. Both U.S. and metric 
measurements are given.

Only the root user can save changes to the default paper catalog.

Any changes made by the root user to the default paper catalog will be overwritten by 
changes subsequently made to the system paper catalog.

The currently open paper catalog cannot be deleted.

If the selected paper color does not match the color defined in the paper supply on the 
printer console, operator intervention may be necessary.
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If you select “Other,” the Other Paper Weights window opens.

Up to three numeric characters may be entered in the text field. The paper weight can be in grams per 
square meter (gsm) or pounds (lb.). You must select a weight designation from the menu. The following 
menu is available only if “lb.” is selected. 

Type—allows you to select a paper type for the current paper definition. When <Any> is selected, jobs 
are printed on the available paper, regardless of type. If you select “Other,” the Other Paper Types window 
opens.

In certain situations, both the Type choices “*” and <*> may appear on the type choice list. If a 
paper with Type <*> is defined and used, the printer receiving the job will use a paper which best 
matches the other parameters in the paper definition, ignoring the type. If a paper with type “any” is 
defined and used, the printer will only use a paper that has a type parameter that is the word, “any.”

Up to 19 characters may be entered in the text field. Valid characters include spaces, numbers 
0 through 9, all lowercase and uppercase letters (a–z, A–Z), diacritical characters
(144–255 ASCII), and the following characters: ! @ # $ % – _ + = : ; , .

You can string multiple paper type definitions together (for example, you can specify a paper type as 
“Recycled3Hole”).

If you select “TransverseTray,” the printer should draw paper from a transverse (or landscape) paper tray. 
“Transverse” refers only to the paper orientation, not to the orientation of the image on the page. This 
setting is useful for certain stapling and folding configurations. 

Mode—allows you to select a paper path (Inserter, 1-Sided, or 1,2-Sided). 

1-Sided—indicates this paper should only be printed on the first side.

1,2-Sided—indicates this paper can be printed either one-sided (simplex), or two-sided (duplex).

Inserter—indicates this paper should only be fed from the Inserter supply and should not be 
printed on.

Modifying Paper Catalogs

To open a paper catalog:

  1. Click the Catalog button in the Print Client Software main window.

The Paper Catalog window opens.

If the specified paper weight does not match the weight defined in the paper supply on the 
printer console, operator intervention may be necessary.

If the selected paper type does not match the type defined in the paper supply on the printer 
console, operator intervention may be necessary.

Only the root user can save changes to the default paper catalog.

Users other than the root user can create catalogs separate from the default catalog using the 
steps in “To save a paper catalog with a new name” on page 5-8.
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  2. Position the pointer over the File button in the Paper Catalog window. Holding down the Menu 
mouse button, select Open Paper Catalog from the 
File menu. 

The Open Paper Catalog window opens.

  3. Select an existing paper catalog.

  4. Click the Apply button.

The selected paper catalog becomes the current paper catalog.

To save a paper catalog:

  1. Position the pointer over the File button in the Paper Catalog window. Holding down the Menu 
mouse button, select Save Paper Catalog from the File menu.

The current paper definitions are saved to the current paper catalog.

To save a paper catalog with a new name:

  1. Position the pointer over the File button in the Paper Catalog window. Holding down the Menu 
mouse button, select Save Paper Catalog As from the File menu.

The Save Paper Catalog window opens.

  2. Type a name for the paper catalog in the Catalog Name text field.

  3. Click the Apply button in the Save Paper Catalog window.

The current paper definitions are saved to the chosen paper catalog.

To delete a paper catalog:

  1. Position the pointer over the File button in the Paper Catalog window. Holding down the Menu 
mouse button, select Delete Paper Catalog from the File menu.

The Delete Paper Catalog window opens.

  2. Select a paper catalog to be deleted.

  3. Click the Apply button in the Delete Paper Catalog window.

The paper catalog is deleted.

Paper Definitions

To create a new paper definition:

  1. Position the pointer over the Edit button in the Paper Catalog window. Holding down the Menu 
mouse button, select New Definition from the Edit menu.

The New Paper Definition window opens.

  2. Type a name in the Paper Name field.

  3. Click the Apply button in the New Paper Definition window.

The new paper type is created. The new paper’s attributes are those currently displayed. The New 

Paper catalogs can be opened only if no files are in the list.
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Paper Definition window closes.

  4. Position the pointer over the Size menu button in the Paper Catalog window. Holding down the 
Menu mouse button, select a size from the Size submenu.

  5. Position the pointer over the Color menu button in the Paper Catalog window. Holding down the 
Menu mouse button, select a color from the Color submenu.

  6. Position the pointer over the Weight menu button in the Paper Catalog window. Holding down the 
Menu mouse button, select a weight from the Weight submenu.

  7. Position the pointer over the Type menu button in the Paper Catalog window. Holding down the 
Menu mouse button, select a type from the Type submenu.

  8. Select the Mode from the drop down list.

  9. Click the Apply button. 

To rename a paper definition:

  1. Position the pointer over the Edit button in the Paper Catalog window. Holding down the Menu 
mouse button, select Rename from the Edit menu.

The Rename Paper window opens.

  2. Type a name.

  3. Click the Apply button.

The selected paper is renamed with the specified name. 

To delete a Paper Definition:

  1. Position the pointer over the Edit button in the Paper Catalog window. Holding down the Menu 
mouse button, select Delete from the Edit menu.

The current paper is deleted immediately. 

If you want the paper catalog modification to be saved permanently, you must save the 
paper catalog as previously described in this chapter.

If you want the paper catalog modification to be saved permanently, you must save the 
paper catalog as described on page 5-8.

You cannot delete the last media definition from a paper catalog.

If you want the paper catalog modification to be saved permanently, you must save the 
paper catalog as described on page 5-8.
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Appendix A Command Line Interface
The command line interface to Print Client Software is sclient_cli.scl, which provides a method to invoke 
the application from the UNIX command line or UNIX scripts, so print requests can be initiated without 
the graphical user interface (GUI).

Individual document file names or an argument file containing a list of document files to be printed can 
be entered on the command line.

• If individual document file names are specified, they must be specified last.

• If a print options file is present on the command line, these options will apply to all document files 
printed in the request.

• If a print options file is not specified on the command line, stored options from a .kco or ,20 file 
within the same directory are used for each document file.

• If stored options do not exist for a file, the user default print options are used. 
These defaults print options are located in /.printdir/client_options/default_options.kco.

Print options files may be constructed by manually editing a file. However, the preferred method for 
creating print options files is through the graphical user interface. Refer to “Opening a Print Options File” 
on page 4-8 and “Saving Print Options” on page 4-9. Optional arguments are available for you to override 
some of the selections in the print options file (for example, number of copies, server, printer, and so forth). 

Options

–c Copies

This argument specifies the number of document sets to be printed. This argument 
overrides the number of copies specified in the print options file. If the operation is a document merge, 
this argument applies to the merged document.

–d Printer

This argument specifies the printer to use. The printer can specify a printer name, a printer type, or indicate 
any printer available (“Any”). This argument overrides the value for the printer specified in the print 
options file.

–f  –
–f  Filename

This argument specifies the full UNIX path for a file that lists the UNIX path for each document file to 
be included in the print request. Document files indicated this way are added to the list before any 
individual document files specified on the end of the command line.

If print options are constructed manually or the selected printer is overridden by a command 
line argument, the print options may be invalid for the selected printer type. The command 
line interface does not flag such errors. The print request is sent to the print server, which 
may detect an error, or to a printer, where incompatible options are either ignored or cause 
the print request to fail. Print options can be viewed and edited as described on page 4-8 
(preferred method), or within a command tool window by typing ‘textedit <file name>’ 
while in the directory where the file is located.

The command line interface cannot be used to print directories of TIFF files.
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–o  –
–o  Options_Filename

This argument indicates that common print options should be applied to all document files. If an 
Options_Filename is supplied, it indicates the UNIX path of the print options file to be used as the common 
print options. If “–” is specified, it indicates that the user default print options should be used. 

–r  –
–R  –
–r  Stored_Name
–R  Stored_Name

This argument indicates that the document files should be stored as resources on the Network Imaging 
System print server as part of the print request. “–R” specifies that the document files should be stored, 
but not printed, “–r” specifies that the document files should be stored and printed. If a Stored_Name is 
specified, it indicates the resource name to use on the system print server. If “–” is specified, then the 
UNIX filenames of the document files will be used. 

–s Server

This argument specifies the Network Imaging System print server to be used to handle the print request.

–x

This argument indicates that Print Client Software should delete the document file and any associated 
print options file after printing it.

Examples

Following are examples of the command line interface.

sclient_cli.scl  /home/lmr/taxes.ps

This prints the document /home/lmr/taxes.ps and uses the user’s preferences and the document’s stored 
print options. If the stored print options do not exist, the user’s default print options are used.

sclient_cli.scl  -o  /home/lmr/tkt  -c  2  -d  lab1  /home/lmr/junk.ps

This prints a single document /home/lmr/junk.ps using the print options file /home/lmr/tkt. Two copies 
are printed on the printer “lab1,” overriding the number of copies and the printer in the print options file.

sclient_cli.scl  -f  /home/lmr/psfiles  -d  lab1  -s  845Pserver  -R  -

This stores all documents listed in the argument file /home/lmr/psfiles on the Network Imaging System 
print server. Stored print options files for each document are used. The print server “845Pserver” is used, 
overriding the value in the user’s preferences. The printer “lab1” is used, overriding the value in any print 
options files. Each document’s UNIX filename is used as its resource name on the system print server.

sclient_cli.scl  -f  /home/lmr/psfiles  -o  -  /home/lmr/taxes.ps  /
home/lmr/phonelist.ps

This prints the documents listed in /home/lmr/psfiles, followed by the documents /home/lmr/taxes.ps and 
/home/lmr/phonelist.ps, all with the same print options. The print options used are the user’s default print 
options.

If a Stored_Name is specified for multiple documents, each file is 
written to this name and will overwrite the previous file. Therefore, 
only the last file of the document list is stored.
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Appendix B Configuration Files
This appendix describes some of the Print Client Software configuration files. You can use any standard 
ASCII text editor to modify the configuration files. You must be logged in as root to edit these files. 

The configuration files reside in three areas:

• /usr/srv/lib/defaults/defaults.scl

Files in defaults.scl are “factory default” files and should never be modified.

• /usr/srv/lib/databases/databases.scl

Files in databases.scl are “system default” files and can be modified by the system administrator.

• ~/.printdir

Files in each user’s .printdir are “user default” files. Some of these files are modified by the user 
and others are modified by Print Client Software.

File Descriptions

Following are descriptions of the Print Client Software configuration files.

databases.scl/server_list

The databases.scl/server_list file lists all of the print servers to which Print Client Software desires access. 
This file can be modified by the system administrator using /usr/srv/bin/config.scl.

databases.scl/printer_types_list

The databases.scl/printer_types_list file lists printer types that should appear in the menus, even if that 
type of printer is not available from the print server.

databases.scl/client_config

The databases.scl/client_config file allows the system administrator to restrict access to certain features 
and functions of Print Client Software.

databases.scl/sys_def_options.kco

The databases.scl/sys_def_options.kco file contains the system default print options. The file can be 
modified by the system administrator using Print Client Software.  The first time a user starts the Print 
Client software, these options are copied to create the user’s default options which can then be modified 
by the user.  If the user wishes to reset to the system defaults, they should delete the contents of the .printdir 
directory in their home directory and restart the Print Client software.

databases.scl/sys_def_preferences

The databases.scl/sys_def_preferences file contains the system default preferences. The first time a user 
starts Print Client Software, these preferences are copied to create the user’s default preferences.

If Print Client Software can be used to modify or create a file, you should use it instead of 
an ASCII text editor.
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databases.scl/media/def_media_catalog.mc

The databases.scl/media/def_media_catalog.mc file is the system default media catalog.

databases.scl/printer_dbs/[hostname]/installed_printer_db

The databases.scl/printer_dbs/[hostname]/installed_printer_db files are database files created by Print 
Server Software. These files are used by Print Client Software to determine the printers that each print 
server knows about and the configuration information for each printer.

databases.scl/update_cat.cfg.scl

The databases.scl/update_cat.cfg.scl file controls whether or not the Print Client system default paper 
catalog is automatically updated to match the Network Imaging System default paper catalog or not.

~/.printdir/client_preferences

The ~/.printdir/client_preferences file contains the user preferences. When Print Client Software is first 
started up, this file is created from a copy of the system default preferences file. This file is modified 
through the Preferences window which is accessed from the Print Client Software main window. 

~/.printdir/client_options/default_options.kco

The ~/.printdir/client_options/default_options.kco file contains the user default print options. When Print 
Client Software is first started up, this file is created from a copy of the system default print options file. 
This file is modified through the File menus which are accessed from the Print Client Software main 
window. 

~/.printdir/media_catalogs/...

The ~/.printdir/media_catalogs/... files are other media catalogs created by the user through the Paper 
Catalog window which is accessed from the Print Client Software main window. 

This file exists for each Print Client Software user. You do not have to be logged in as root 
to edit this file.

This file exists for each Print Client Software user. You do not have to be logged in as root 
to edit this file.

This file exists for each Print Client Software user. You do not have to be logged in as root 
to edit this file.
B-2 Print Client User’s Guide Release 4



Configuration Files
/.printdir/media_catalogs/def_media_catalog.mc

The /.printdir/media_catalogs/def_media_catalog.mc file is the Print Client default catalog for all users.  
Depending upon the catalog configuration, see “Default Paper Catalog:” on page 1-7. This file is either 
automatically updated whenever the Network Imaging System Paper Catalog is modified or it is not 
automatically updated. If it is not automatically updated, this file is modified by the root user using the 
Paper Catalog window which is accessed from the Print Client Software main window.

Each Print Client user has a Unix link from ~/.printdir/media_catalogs/
def_media_catalog.mc to the root’s default catalog file.  Only the root user can modify the 
file.
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Appendix C Modify Options

The Modify Options Interface

The Modify Options interface for the Print Server Software has been replaced with an enhanced version 
of the Print Client Software. When a job is chosen to be modified, the Sun print client is launched according 
to the following requirements. These requirements represent differences between the behavior of the 
Network Imaging System print client and its behavior as the Modify Options interface.

  1. The initial values that are to be displayed for all print options are based on the job’s DSC/KDK 
header except when there is a Printer Command Set (PCS)  file associated with the print file which 
contains the true representation of the desired options. For print options not specified in the job 
header or PCS file, whichever is appropriate, Sun Client default values are used, consistent with the 
current behavior of the Sun Client.

The following are the cases for which the PCS values are used instead of the options expressed in 
the print file header:

If all of the following conditions are true, the print options in the PCS file 
are used.

• The job was submitted from a remote queue on another Network Imaging System print server.

• The job was modified on that server.

• The sending server is running a previous version of the Print Server Software and so the 
modified options are represented in the accompanying PCS file.

If both of the following conditions are true, the print options in the PCS file 
are used.

• The job was submitted via the scan directory.

• A PCS file associated with the job was provided in the tkt scan directory, and it contains either 
a PCS Protocol Mode code (PM0) or no Protocol Mode.

If the following condition is true, the print options in the PCS file are used.

• The job is a PPD pamphlet job.

  2. The Job ID appears as the Filename.

  3. The Print button is relabeled “Reprint.”

  4. Printer/Type is set to the printer name and type originally requested in the job.

  5. The File Type is set to the value determined by the Print Server Software which is represented by 
the PCS file.

  6. The following controls are disabled. The default behavior is shown in parentheses, where 
appropriate:

• Edit menu

• Preferences → Filename Display As (Filename)

• Preferences → Server (Local)

• Drag and Drop Target

  7. When you select the Reprint button, a header is prepended consistent with the print client with the 
following addition:
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• If a Job ID had been assigned to the job by the Network Imaging System print server, the Job 
ID value found in the PCS file is prepended.

  8. When you select Reprint, the job is submitted to NCS using the dqp.scl protocol after prepending a 
new header specifying the options that were indicated in the system print client user interface at the 
time (consistent with the current functionality of the system print client). This causes the job to be 
re-autoqueued to the local system print server.

  9. After the job is resubmitted, the Print Client Software interface will be automatically exited.

10. If the Print Client Software window is closed using the OpenWindows window controls or by 
choosing Exit from the File menu, the user interface is exited and the job is placed in its original 
queue.

11. The modify operation is logged in the Job Management log as a Modify of the original job. When 
the job is re-autoqueued, it goes through the same job states as a newly arriving job (that is, 
spooled, queued) although the Job ID will be the same as before it was modified.

12. All Print Client Software user-specific files which would normally be stored under the client user’s 
home directory are stored in /var/spool/srv_modify/.printdir instead.

This approach has the following limitations:

• When default options are used, embedded print options (such as setpagedevice) may be 
overridden.

• When the job is resubmitted, it may not return to the same queue.

• When the job is resubmitted, the job will autoqueue as the last job in its queue. If the user 
wishes to prioritize the job, a separate top-queuing step will be required.

13. Consistent with the behavior of the Print Client Software, if any papers specified in the original job 
are not in the Print Client Software paper catalog, the mismatching paper definitions are replaced 
with papers that are in the catalog. In such cases, a warning is displayed.  The modify options 
interface uses the root’s paper catalog as the default paper catalog.

14. You can select multiple files to be modified at once. When this is done, the jobs use individual or 
common options consistent with the current functionality of the Print Client Software.
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Appendix D Printer Specific Notes

Network Imaging System

Setting Up Printers

When you are printing without choosing a print server (that is, using the <None> server entry), you must 
create a database of printers before you can print to them using Print Client Software.

When attempting to print jobs to printers attached to remote servers, it is preferable to select the remote 
server by its host name for the server preference rather than the <Local> server, even if the local server 
has queues for the remote printers.

Available Print Options

The following table contains the Print Client Software options that are supported by the Network Imaging 
System.

Print Options and <Any> Printer Types

When the selected printer type is <Any>, you can choose any options available within the Print Client 
Software. Not all options are available on every printer. It is possible to select a combination of options 
that may not print successfully. To avoid document configurations that cannot print correctly, select your 
printer from the printer type list.

While Network Imaging Systems can be set up with a server device of  “<None>,” print 
requests sent to those printers are routed through the Print Server Software loaded on the 
printer’s Sun workstation.
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Table D-1  Print options

Feature Option Window

Body Paper Main

Copies 1–99,999

Document Page Order First Page First

Last Page First

File Type Adobe PostScript

PCL5

PCL6

Lineprinter

CCITT

PDF

KGL

Job Mode Simplex

Duplex

Pamphlet

Interleaves

Pages Range

Front/Back Covers Preprinted/Blank 

Print Side 1

Print Side 2

Print Both Sides

Front/Back Cover Paper

Collated Copies
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Device Stacker Main

Booklet Maker

Top Exit

Stapler

Folding None

Saddle Fold, 
22 sheets, max

Stacking Offset

Straight

Stapling None

Top

Bottom

2 Left Edge

Saddle Stitch

Rotation 0

90

180

270

Charge Number 31 characters, max General Options

Deliver To 64 characters, max

Destination 99 characters, max

Operator Message 80 characters, max

User ID 63 characters, max

E-mail to 63 characters, max

Feature Option Window
Release 4 Print Client User’s Guide D-3



Paper CatalogPaper Color White

Red

Yellow

Blue

Green

Clear

Any

Paper Size Letter

Legal

Ledger

A4

A3

Letter Tab

A4 Tab

8 x 10.5

manual

9 x 14 in.

8 x 10 in.

8.5 x 10 in.

RA4 (215 x 305 mm)

RA3 (305 x 430 mm)

14 x 17 in.

12 x 18 in.

14 x 18 in.

Paper Type plain

cover

transparency

color

punched

recycled

Feature Option Window
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Paper Weight 20 lb. Bond Paper Catalog

24 lb. Bond

32 lb. Bond

50 lb. Bond

Mode Inserter

1-Sided

1, 2-Sided

New Chapter n, n...n, n..., ...n, 1... Paper Exceptions

Inserts ^n, n^

Slipsheets n, n...n, n..., ...n, 1...

New Chapter Finish Separately

Paper

Exception Mode <Job Mode>

Simplex

Duplex

Filename(s) display as Pathname(s) Preferences

Filename(s)

Print Options Individual

Common

Units inches

cm

mm

points

centipoints

Feature Option Window
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* The indicated printers accept fewer characters than the Print Client Software permits.

Printing a Two-Sided, Stapled Document with Covers

Print Options

 Job Mode—

Interleaves—   

Compile Only-Do Not Print Printer Controls

Custom Printer Commands

Interleave Paper

Interleaves Printed

Blank

Maximum Pamphlet Size 1–999
(4–3997 pages)

Paper Mismatch Handling Notify then Cancel

Proof Set

Status Page None Printer Controls

Always

Always-1st Page Only

Only on Error

Status Page Paper

Two Sided Format Flip on Long Edge

Flip on Short Edge

Set Separators

Set Separator Paper

For the Network Imaging System, you can have front and back covers that have different 
attributes (plex of the job and paper type).

For example, you can specify a duplex front cover on plain paper and a simplex back cover 
on blue paper. Pamphlets, however, can have only one cover specified.

Paper exceptions will be ignored when the Interleaves Job Mode is selected.

Feature Option Window
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File Type—

Emulation Types—

Covers—

Stapling—allows you to specify if (and where) printed sets are stapled. Different options  are available 
depending on the selected printer type.

Short-edge-fed, Top Staple—

On the Network Imaging System printers, you can work around image orientation problems by using the 
Rotation features in the Page Placement Options window. Refer to Section 4 “Printer Controls” for more 
information.

Z-fold—

If the file type is set incorrectly, jobs may not print as expected. When using the Print Client 
for modifying the options of the jobs in the Network Imaging System print server queues, 
changing the File Type may yield unexpected results.

File Type

Adobe PostScript

PCL5

PCL6

Lineprinter

CCITT

Adobe PDF

KGL

For optimum printer throughput with the Network Imaging System, if the document is to be 
printed as a pamphlet with cover options “Print Side 1” or “Print Side 2,” it is preferrable to 
recreate the document with duplex covers. To change the covers to duplex, in the original 
document, insert a blank page or page break adjacent to the cover page and then when using 
the print client, choose “Print Both Sides” for the cover option.

Choosing Cover “Print Side 1” in jobs sent to the Booklet Maker will cause the job to be 
redirected to the top exit. To avoid this problem, regenerate the print-ready file with a blank 
page on page 2. When reprinting the file using the Print Client, choose “Print Both Sides.”

Rotate Front and Back are not operational for the Network Imaging System. Choose Both to 
rotate both sides of the pages.

This feature is not available on the Network Imaging System.
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Printer Controls

Paper Mismatch Handling—the action the printer will take if a specified paper, stacking, and/or stapling 
option does not match the option displayed on the printer console.

Table D-2  Paper mismatch handling 

Maximum Pamphlet Size—allows you to specify the maximum size of your pamphlet. You also can 
use this field to break up a large job into multiple smaller pamphlets that can be bound together to make 
a book.

The maximum number of pages is printer-dependent.

Table D-3  Maximum pamphlet sizes

Set Separators—when checked, document sets are delivered with a blank sheet of paper between sets 
when multiple sets are requested. Using separators provides easy retrieval of document sets and is an 
alternative to offset stacking. If the check box is selected, a finished job has separator sheets between sets.

Figure D-1  Example of set separators

Printer Type Paper Mismatch Handling Options 

Substitute Notify then 
Cancel

Trust Me

Network 
Imaging 
System

Not supported A message 
describing the 
mismatch appears on 
the printer console. 
Jobs that time out are 
put into a hold queue.

Not supported

Printer Type Maximum Pamphlet Size

Network Imaging System 22 sheets (88 pages) folded and stapled
250 sheets (999 pages) not folded or stapled

set

set
separators

3

2

1

With separators
set

3

2

1

Without separators
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Paper Options 

70cp-II Printers

Setting Up the System Defaults

The system defaults were established during installation. You should establish system defaults for the 
Preferences window before you use Print Client Software. You must be logged in as root in OpenWindows 
to modify any system default. The fields in the Preferences window are described on page 1-10.

To switch to a different paper catalog:

If you are adding a new printer to your network that is a different type than used previously, you may 
want to add the standard paper definitions for that printer type to your current default paper catalog, or 
replace your default catalog with the Print Client combined paper catalog which includes the standard 
paper definitions for all printers.

For example, if you have been using the Print Client Software with a Network Imaging System and have 
added a copier-printer to your network, you may want to either switch to the combined paper catalog or 
add the copier-printer paper definitions to your current catalog.

  1. As root, type  cd /usr/srv/lib/databases/databases.scl/media  [RETURN].

  2. Type  cp /.printdir/media_catalogs/def_media_catalog.mc . [RETURN].

  3. Enter the following command:

To add the 70cp-II copier-printer paper definitions to your current catalog:

Type cat is70_media_catalog.mc >> def_media_catalog.mc [RETURN].

To add the paper definitions for all supported printers from the combined paper
catalog to your current catalog:

  1. Type cat combined_media_catalog.mc >> def_media_catalog.mc [RETURN].

  2. Type  cp def_media_catalog.mc /.printdir/media_catalogs/  [RETURN].

  3. Enter the following commands:

cp -p combined_media_colors media_colors  [RETURN]

cp -p combined_media_sizes media_sizes  [RETURN]

cp -p combined_media_types media_types  [RETURN]

cp -p combined_media_weights media_weights  [RETURN]

Available Print Options

The following table contains the Print Client Software options that are supported by the 70cp/70cp-II and 
1580 printers.

The Network Imaging System honors only six paper type requests in a job, including body 
paper, covers, paper exceptions, and so forth.

The period (.) is part of the command.
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Print Options and <Any> Printer Types

When the selected printer type is <Any>, you can choose any options available within the Print Client 
Software. Not all options are available on every printer. It is possible to select a combination of options 
that may not print successfully. To avoid document configurations that cannot print correctly, select your 
printer from the printer type list.

Table D-4  Print options

Feature Option Window

Body Paper Main

Copies 1–999

Document Page 
Order

First Page First

File Type Adobe PostScript

PCL5

Job Mode Simplex

Duplex

Pamphlet

Interleaves

Orientation Default

Portrait

Landscape

Pages Range

Front/Back Covers Preprinted/Blank 

Print Side 1

Print Both Sides

Front/Back Cover 
Paper
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Red Automatic Color

Red

Green

Blue

Yellow

Black

Green Automatic

Red

Green

Blue

Yellow

Black

Blue Automatic

Red

Green

Blue

Yellow

Black

Cyan Automatic

Red

Green

Blue

Yellow

Black

Magenta Automatic

Red

Green

Blue

Yellow

Feature Option Window
Release 4 Print Client User’s Guide D-11



Yellow Automatic Color

Red

Green

Blue

Yellow

Black

Black Automatic

Red

Green

Blue

Yellow

Black

All Bitmaps Automatic

Red

Green

Blue

Yellow

Black

Collated Copies Main

Device Finisher

Folding None

Saddle Fold

Z-fold

Stacking Offset

Straight

Stapling None

Top

Bottom

2 Left Edge

3 Left Edge

Saddle Stitch

Feature Option Window
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Charge Number 31 characters, max General Options

Destination 99 characters, max

Operator Message 80 characters, max

User ID 63 characters, max

Adjust Orientation

Mode 1-Sided Paper Catalog

1,2-Sided

Paper Color White

Red

Yellow

Blue

Green

Clear

Paper Size Letter

Legal

Ledger

A4

A3

Letter Tab

A4 Tab

Feature Option Window
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Paper Type plain Paper Catalog

cover

transparency

color

punched

recycled

3hole

4hole

letterhead

label

shortedge

inserttray

Transverse Tray

tab

special

tray1

tray2

tray3

<Any>

Other

Paper Weight 20 lb. Bond

24 lb. Bond

32 lb. Bond

50 lb. Bond

New Chapter n, n...n, n..., ...n, 1... Paper Exceptions

Inserts ^n, n^

Slipsheets n, n...n, n..., ...n, 1...

Paper

Exception Mode <Job Mode>

Simplex

Duplex

Feature Option Window
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* The indicated printers accept fewer characters than the Print Client Software permits.

Filename(s) display 
as

Pathname(s) Preferences

Filename(s)

Print Options Individual

Common

Units inches

cm

mm

points

centipoints

Compile Only-Do 
Not Print

Printer Controls

Custom Printer 
Commands

Interleave Paper

Interleaves Printed

Blank

Maximum 
Pamphlet Size

1–30
(4–120 pages)

Paper Mismatch 
Handling

Substitute

Notify then Cancel

Trust Me

Proof Set

Status Page None Printer
Controls

Always

Always-1st Page Only

Only on Error

Status Page Paper

Two Sided Format Flip on Long Edge

Flip on Short Edge

Set Separators

Set Separator Paper

Feature Option Window
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Printing a Two-Sided, Stapled Document with Covers

Print options

Pamphlet—output is printed so sets can be saddle-folded (folded in half) and formatted as a book. Blank 
pages are added by the printer at the end of the document to make an even multiple of four pages.

Any blank pages selected with Pamphlet mode are counted as part of the maximum pamphlet size. For 
example, if Preprinted/Blank is selected as the Front Cover option for a 100 page pamphlet, a maximum 
pamphlet size greater than 25 sheets should be selected.  

On the  70cp-II copier-printer, you can get the desirable printed result if you set up the target paper supply 
in the “short-edge-fed” orientation and select “Top” in the Stapling field.

Figure D-2  Example of stapling on the short edge

Printer Controls

Paper Mismatch Handling—the action the printer will take if a specified paper, stacking, and/or stapling 
option does not match the option displayed on the printer console.

For the 70cp-II copier-printer, you can have front and back covers that have different 
attributes (plex of the job and paper type).

For example, you can specify a duplex front cover on plain paper and a simplex back cover 
on blue paper. Pamphlets, however, can have only one cover specified.

When printing pamphlets on a 70cp-II copier printer, specify a paper that is pulled from a 
short-edge-fed paper supply.

When folding and stapling pamphlets with a 70cp-II 
copier-printer, you may have to adjust mechanical settings inside the printer accessories. 
For more information about pamphlets, refer to your printer’s user guide.

Short-edge-fed, Top Staple

Alternative

front
cover

Direction of 
Paper Path
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Table D-5  Paper mismatch handling options

Maximum Pamphlet Size—allows you to specify the maximum size of your pamphlet. The maximum 
number of pages is printer-dependent.

Paper—subfields allow you to choose a paper for job header and status pages. 

Color

The Color window allows you to customize the mapping of color components to toners when printing 
with accent color.

To open the Color window:

  1. Position the pointer over the Document button in the Print Client Software main window. Holding 
down the Menu mouse button, select Color from the Document menu.

The Color window opens.

Printer Type Paper Mismatch Handling Options 

Substitute Notify then 
Cancel

Trust Me

70cp-II A message 
describing the 
mismatch appears on 
the printer console. If 
no operator action is 
taken within the 
printer- controlled 
time span (120 
seconds), the printer 
selects the closest 
match to the 
requested option.

A message 
describing the 
mismatch appears on 
the printer console. If 
no operator action is 
taken within the 
printer-
controlled time span 
(120 seconds), the 
job is cancelled.

The printer selects 
the closest match to 
the requested option.

Printer Type Maximum Pamphlet Size

70cp-II 15 sheets (60 pages) folded and stapled
30 sheets (120 pages) not folded or 
stapled

When you use the 70cp-II copier-printer, if you select “<Default Paper>,” status pages will 
print on the paper that is in the main paper supply, regardless of the selection in the Body 
Paper field in the Print Client Software main window.

For more information about defining new papers, refer to Section 5 “Paper Options”.
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Field Descriptions

Accent Color—when checked, accent color is available. When this box is not checked, the other fields 
in this window are grayed out and accent color is not available. 

Display Color—lists the color components that can be mapped to the toners installed in the system. This 
represents the colors of objects and text on your screen.

Printer Color—allows you to map color components either to automatic or custom specifications. You 
can customize the mapping of color components to toners through selections in this field. For example, 
the black component could be mapped to a red toner. You can customize the mapping of any or all of the 
eight color components. The components that are not custom mapped continue to be mapped 
automatically.

Up to four toners (black and three colors) can be selected. If you select more than four toners and click 
the Apply button, a warning message appears.

The default selection is “Automatic.” If you select “Automatic” in the Printer Color field, the printer will 
automatically map the color components that you selected and applied to the document to the installed 
toners at print time. No user intervention is necessary.

Apply—saves any changes you have made.

Reset—resets all values in the window to what they were when the window was opened or the Apply 
button was last clicked.

Accent Color will not print on half-Letter pamphlets for IS70-II printers.

If the file you are printing contains an encapsulated PostScript language file created using 
“XV” on the Sun system, the file does not print when using accent color.

When printing to the 70cp-II copier-printer, some documents created by drivers may print 
in color even when the Accent Color check box is not selected. These documents contain 
embedded PostScript language commands which allow the 70cp-II copier-printer to detect 
that the documents contain color. You can override the default color mode of these docu-
ments and force black-only printing on the 70cp-II copier-printer by performing the follow-
ing steps:

Position the pointer over the Document button in the Print Client Software main window. 
Holding down the Menu mouse button, select Printer Controls from the Document menu.

The Printer Controls window appears.

Move the pointer into the Custom Printer Commands text box.

Type %KDKAccentColor: off in the text box. This command is case-sensitive.

Click the Apply button to save the changes.

The %KDKAccentColor: off command is supported only by the 70cp-II copier-printer. If 
this custom command is sent to another printer, unexpected printing results will occur.

Custom printer commands are saved with the rest of the selected options in the print options 
file. As a result, if you retrieve the document and its associated print options file, it prints in 
black-only unless you delete the %KDKAccentColor: off command from the Custom 
Printer Commands text box.

The %KDKAccentColor: off command takes precedence over the status of the Accent Color 
check box in the Color window. However, you can still use the Color window to customize 
display color mapping.
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Accent Color Mapping

The Accent Color filter takes color specifications in red, green, and blue (RGB) and cyan, magenta, 
yellow, and black (CMYK) color spaces. The color mapping algorithm used by the Accent Color filter 
converts the color spaces into the HSB (hue, saturation, and brightness) color model. The hue is a value 
between “0" and “1" that indicates which of the following colors is represented: black, gray, white, red, 
green, blue, cyan, magenta, or yellow.

Table D-6  HSB Color Mapping

The following chart shows the relationship between hue and the color it indicates.

Figure D-3  Hue versus color

The saturation value is calculated by the following formula:

saturation value = maxRGB – minRGB / maxRGB

Color Hue Saturation Brightness Default Toner

Black 0 0 0 Black

Gray 0 0 >0 to <1.0 Black

White 0 0 1 n/a

Red 0.875 to 1.0
0 to 0.125

>0 to 1.0 >0.4 to 1.0 Red

Green 0.208 to 0.458 >0 to 1.0 >0.4 to 1.0 Green

Blue 0.542 to 0.792 >0 to 1.0 >0.4 to 1.0 Blue

Cyan 0.458 to 0.542 >0 to 1.0 >0.4 to 1.0 50% Blue

Magenta 0.792 to 0.875 >0 to 1.0 >0.4 to 1.0 50% Red

Yellow 0.125 to 0.208 >0 to 1.0 >0.4 to 1.0 Yellow or 
50% Green

Dark Colors >0 to 1.0 >0 to 1.0 >0 to 0.4 Black

Green

Red

Yellow

Cyan

Blue Magenta

1
0
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The brightness value is the maximum value of the RGB representation of color. A brightness value of 
“1" represents a pure color (for example, 1 0 0 RGB is a pure red). A brightness value less than “1" 
represents a darker shade of a color approaching black.

Brightness values of 0.4 or less are represented as shades of gray, as determined by the following formula:

% gray = 1 – (0.3R + 0.59G = 0.11B) ∗  100

The percentage of toner used to represent the requested RGB values for colors other than black, gray, or 
white is determined by the following formula:

if brightness < 0.98 and brightness > 0.4

then brightness = 1.0 – brightness + 0.4

% toner = brightness ∗  saturation ∗  100

Cyan, magenta, and yellow (if yellow toner is not present), are mapped to 50% of their default toner as 
defined on the previous page. If these colors are mapped specifically to a color in the printer driver, they 
will be mapped 100% to the requested toner.

A pure color is represented by applying 100% of a toner. A darker shade of a color cannot be represented 
without mixing it with black; however, toners cannot be mixed. Darker shades of a color are represented 
by 40 to 100% of a toner (represented in the formula shown above, where brightness < 0.98).

If any of the red, green, or blue toners is not available and the colors are mapped to “Automatic” in the 
Printer Driver, they will be represented by the first available toner in the following priority order: red, 
green, blue, yellow.

The following formula is used to calculate the percent of toner that will be used by the 1580 copier-printer, 
the 70cp copier-printer, or the 70cp-II copier-printer:

% toner = 1.0 – (0.3R + 0.59G + 0.l11B) ∗  100 

The following illustration shows the relationship between brightness and saturation.

Figure D-4  Brightness versus saturation

For every brightness level, a dark-to-light range can be specified.

Some applications give you color editing capabilities that can control the hue, saturation, and luminance. 
A 0.5 luminance value equals a 1.0 brightness value. As the luminance goes from 0.5 to 1.0, the shade 
of the color will become darker. As the value goes from 0.5 to 0, the shade will become lighter.

Color Mapping Tables

The tables in this section may help you understand how the 70cp-II copier-printer map display colors.

Brightness

LightestDarkest
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RGB and CMYK Color Mapping Table

The following table shows the setrgbcolor and setcmykcolor values that will be used for each 
display color, respectively.

Table D-7  RGB and CMYK color mapping

Filter Tables

If a selected color is a mixture of the color separations that are available, then the most dominant of the 
RGB values determines the toner that will be used. The mapping for RGB color separations is based on 
the following formula:

% gray = (red ∗  0.30) + (green ∗  0.59) + (blue ∗  0.11)

The following tables show how the filter will map the display color requested in the job to the color toners 
(one, two, or three) that are installed in the 1580 copier-printer, the 70cp copier-printer, and the 70cp-II 
copier-printer.

Table D-8  One color station in printer

Table D-9  Two color stations in printer

Color Red Green Blue Yellow Magenta Cyan Black White

RGB 1 0 0 0 1 0 0 0 1 1 1 0 1 0 1 0 1 1 0 0 0 1 1 1

CMYK 0 1 1 0 1 0 1 0 1 1 0 0 0 0 1 0 0 1 0 0 1 0 0 0 0 0 0 1 0 0 0 0

Display Color Red Toner Only Green Toner Only Blue Toner Only Yellow Toner Only

Red 100% 70% 70% 70%

Green 41% 100% 41% 41%

Blue 89% 89% 100% 89%

Yellow 11% 50% 11% 100%

Magenta 50% 59% 59% 59%

Cyan 30% 30% 50% 30%

Display 
Color

Red & 
Green 
Toners

Red & Blue 
Toners

Red & 
Yellow 
Toners

Green & 
Blue Toners

Green & 
Yellow 
Toners

Blue & 
Yellow 
Toners

Red 100% Red 100% Red 100% Red 70% Green 70% Green 70% Blue

Green 100% Green 41% Red 41% Red 100% Green 100% Green 41% Blue

Blue 89% Red 100% Blue 89% Red 100% Blue 89% Green 100% Blue

Yellow 50% Green 11% Red 100% Yellow 50% Green 100% Yellow 100% Yellow

Magenta 50% Red 50% Red 50% Red 59% Green 59% Green 59% Blue

Cyan 30% Red 50% Blue 30% Red 50% Blue 30% Green 50% Blue
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Table D-10  Three color stations in printer

Paper Options 

Type—allows you to select a paper type for the current paper definition.  

These special paper types provide for customization of the paper catalogs and printer configuration.

Table D-11  Special paper types

To use these paper types, you must first configure the printer paper supplies. Except for “inserttray,” these 
paper types are not used in any of the predefined entries in the paper catalogs. You must create the custom 
paper definitions. 

Display 
Color

Red & Green & 
Blue Toners

Red & Green& 
Yellow Toners

Red & Blue & 
Yellow Toners

Green & Blue & 
Yellow Toners

Red 100% Red 100% Red 100% Red 70% Green

Green 100% Green 100% Green 41% Red 100% Green

Blue 100% Blue 89% Red 100% Blue 100% Blue

Yellow 50% Green 100% Yellow 100% Yellow 100% Yellow

Magenta 50% Red 50% Red 50% Red 59% Green

Cyan 30% Red 30% Red 50% Red 50% Blue

You can use two exception papers with the 70cp-II copier-printer.

Type Intended Use

shortedge Some jobs require paper that is short-edge-fed. Paper can be 
loaded in the short edge orientation and have one of the usual 
type designations such as “plain.” However, it may be helpful to 
designate the paper type as “shortedge.”

tray1, tray2,
tray3, inserttray

You may prefer to select paper by tray number, rather than by 
paper attributes. These types allow you to do so.

Any paper type can be used in any paper supply. However, it is easy to confuse “Insert Sup-
ply,” which is a paper supply that is located in the printer’s finisher, with “inserttray,” which 
is a paper type that is valid for any paper supply. For ease of use, you can designate the 
“inserttray” paper type only for the Insert Supply.

The Insert Supply is intended only for blank pages or preprinted inserts. You cannot print on 
paper in the Insert Supply.

If you do not have a finisher, you can use the “inserttray” paper type for another paper sup-
ply. You can also use “inserttray” for another paper supply to use more than one insert 
paper.
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92p/92sp Printers

Setting Up Printers

When you are printing without choosing a print server (that is, using the <None> server entry), you must 
create a database of printers before you can print to them using Print Client Software.

When attempting to print jobs to printers attached to remote servers, it is preferable to select the remote 
server by its host name for the server preference rather than the <Local> server, even if the local server 
has queues for the remote printers.

Setting Up the System Defaults

The system defaults were established during installation. You should establish system defaults for the 
Preferences window before you use Print Client Software. You must be logged in as root in OpenWindows 
to modify any system default. The fields in the Preferences window are described on page 1-10.

To switch to a different paper catalog:

If you are adding a new printer to your network that is a different type than used previously, you may 
want to add the standard paper definitions for that printer type to your current default paper catalog, or 
replace your default catalog with the Print Client combined paper catalog which includes the standard 
paper definitions for all printers.

For example, if you have been using the Print Client Software with a Network Imaging System and have 
added a copier-printer to your network, you may want to either switch to the combined paper catalog or 
add the copier-printer paper definitions to your current catalog.

  1. As root, type  cd /usr/srv/lib/databases/databases.scl/media  [RETURN].

  2. Type  cp /.printdir/media_catalogs/def_media_catalog.mc . [RETURN].

  3. Enter the following command:

To add the 92p printer paper definitions to your current catalog:

  1. Type cat 92p_media_catalog.mc >> def_media_catalog.mc [RETURN].

To add the paper definitions for all supported printers from the combined paper
catalog to your current catalog:

  1. Type cat combined_media_catalog.mc >> def_media_catalog.mc [RETURN].

  2. Type  cp def_media_catalog.mc /.printdir/media_catalogs/  [RETURN].

  3. Enter the following commands:

cp -p combined_media_colors media_colors  [RETURN]

cp -p combined_media_sizes media_sizes  [RETURN]

While 92p/92sp printers can be set up with a server device of “<None>,” print requests sent 
to those printers are routed through the Print Server Software loaded on the printer’s Sun 
workstation.

The period (.) is part of the command.
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cp -p combined_media_types media_types  [RETURN]

cp -p combined_media_weights media_weights  [RETURN

Setting Up User Defaults

After you install Print Client Software, you can set up the user default paper catalog and user default print 
options.

Server—Allows you to select a specific print server. You can also choose to print directly to a printer by 
selecting <None> in the Server list box. Once documents have been added to the document scrolling list, 
you cannot make any changes in the Server field.

Available Print Options

The following table contains the Print Client Software options that are supported by the 92p/92sp printers.

Print Options and <Any> Printer Types

When the selected printer type is <Any>, you can choose any options available within the Print Client 
Software. Not all options are available on every printer. It is possible to select a combination of options 
that may not print successfully. To avoid document configurations that cannot print correctly, select your 
printer from the printer type list.

While 92p/92sp printers can be set up with a server device of “<None>”, print requests sent 
to those printers are routed through the Print Server software loaded on the printer’s Sun 
workstation .
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Table D-12  Print options

Features Option Window

Body Paper Main

Copies 1–65535

Document Page 
Order

First Page First

File Type Adobe PostScript

Job Mode Simplex

Duplex

Front/Back Covers Print Side 1 

Print Both Sides

Front/Back Cover 
Paper

Collated Copies

Device Finisher

Top Exit

Side Exit

Stacking Offset

Straight

Stapling None

Top

Bottom

2 Left Edge

Charge Number 31 characters, max General Options

Deliver To 64 characters, max

Destination 99 characters, max

Operator Message 80 characters, max

User ID 63 characters, max

E-mail to 64 characters, max
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Mode 1-Sided Paper Catalog

1, 2-Sided

Paper Color White

Red

Yellow

Blue

Green

Clear

<Any>

Other

Paper Size Letter

Legal

A4

Letter Tab

A4 Tab

8 x 10.5

Paper Type plain Paper Catalog

cover

transparency

color

punched

recycled

3hole

4hole

letterhead

<Any>

Other

Paper Weight 20 lb. Bond

24 lb. Bond

32 lb. Bond

50 lb. Bond

Features Option Window
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* The indicated printers accept fewer characters than the Print Client Software permits.

New Chapter n, n...n, n..., ...n, 1... Paper Exceptions

Slipsheets n, n...n, n..., ...n, 1...

Paper

Exception Mode <Job Mode>

Simplex

Duplex

Filename(s) display 
as

Pathname(s) Preferences

Filename(s)

Print Options Individual

Common

Units inches

cm

mm

points

centipoints

Custom Printer 
Commands

Printer Controls

Job Header Page

Paper Mismatch 
Handling

Substitute

Status Page None

Always

Only on Error

Two Sided Format Flip on Long Edge

Flip on Short Edge

Set Separators

Set Separator Paper

Features Option Window
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Printing a Two-Sided, Stapled Document with Covers

Printer Controls

Paper Mismatch Handling—the action the printer will take if a specified paper, stacking, and/or stapling 
option does not match the option displayed on the printer console.

Table D-13  Paper mismatch handling options   

Paper Options 

Page List—lists the page(s) where specified paper types are to be used in the document.

 Size—allows you to select a paper size for the current paper definition. 

Paper Definition—

For the 92p/92sp printers, if both front and back covers are selected, they must have the 
same attributes (sides and paper type).

Printer Type Paper Mismatch Handling Options

Substitute Notify then Cancel Trust Me

92p/92sp A warning message 
appears at the 92p/
92sp system 
console, but no 
operator 
intervention is 
required. The 
printer selects the 
closest match to the 
requested options.

Not supported Not supported

You can use one exception paper in the 92p/92sp printer.

The ^n and n^ options are not available for the 92p/92sp printers.

The printable image area for a 92p/92sp printer is limited to 8.5″ x 13.65″.

When you are defining a paper for use with the 92p/92sp printer, the paper name you enter 
should be exactly as specified on the 92p/92sp printer as a paper tag.
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